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STEP inside design magazine presents Stretch,
a two-day conference featuring presentations
from design luminaries working across disciplines
and hands-on workshops to push your creativity
into fresh new territory.

May 6-8, 2004, Chicago

October 14-16, 2004, Washington DC 

For more information or to register call 888-698-8545
or visit www.stepinsidedesign.com
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It is possible to create 
low-budget special 
effects without look-
ing cheap (page 44).

4  DynamicGraphics

APRIL/MAY 2004 - VOLUME 9 NUMBER 2



Finally, a business collection 

that gets real.

Let’s do Business takes a

comprehensive look at the real

world of business with over 2,000

refreshing images on DVD. This

extensive selection of business

subjects, styles, and models 

works as hard as you do. 

Call your authorized Digital Vision

representative to request your new

Let’s do Business catalogue today!

Real people. 

Real business locations. 

Real life scenarios.

Blood, sweat & tears

11
38

09
6

R
ob

 M
el

ny
ch

uk

Authorized Distributors:

Artzooks.com
Creatas.com
Fotosearch.com
Futurestock.com
Gettyimages.com
Matton.com
Mediabakery.com
Picturequest.com
Punchstock.com
Veer.com
Wonderfile.com

 Circle 4 on Connections card



6 DynamicGraphics

GRAPHICSD
Y

N
A

M
IC

CONTENTS

REGULARS

8 From the Staff

12 Letters
         Patterns, logos, and color

62 Workspace Savvy
         The latest must-haves for desktop and library

64 Classifieds/Connections

72 Cover to Cover/Coming Up

ONE-MINUTE WORKSHOP

16  Softening Image Edges

Although the techniques and ideas outlined in Dynamic Graphics are offered with 
the best possible intentions, the publication or its publisher will assume no liability 
for their success or failure in any real-world business application.

Dynamic Graphics magazine (ISSN 1094-2548/USPS 016-929) is published 
bimonthly by Dynamic Graphics Group, 6000 N. Forest Park Drive, Peoria, IL 
61614-3592, for $36 per year in the U.S. Single copies are $7.95 each. Prices 
vary outside the U.S. April/May 2004, Vol. 9, No. 2. Canadian GST Account No. 
125145193. Canada Post Permit No. 2493675. 

POSTMASTER: Send change of address forms to Dynamic Graphics magazine, P.O. 
Box 9006, Maple Shade, NJ 08052-9006. Periodical postage rates paid at Peoria, 
Ill., and additional mailing offices. Visit www.dynamicgraphics.com/dgm and click 
Subscriber Services, or e-mail directly at dgm@starrcorp.com. 

© 2004 Dynamic Graphics, Inc. All rights reserved. Contents of this magazine may 
not be reproduced in any manner without written consent from the publisher. 
Mention of any product does not constitute endorsement by Dynamic Graphics 
magazine. Dynamic Graphics magazine assumes no responsibility for return of 
unsolicited manuscripts, photos, art, or cartoons, and reserves the right to reject 
any editorial or advertising materials. Unsolicited materials should be accompanied 
by a self-addressed, stamped envelope. Dynamic Graphics magazine is a regis-
tered trademark of Dynamic Graphics, Inc.  

Production Notes:
This issue was produced using InDesign 2.0 on PowerMac G4s. Text imported from 
Microsoft Word and set in Clarendon BT, Gotham, and Adobe Garamond. Unless 
otherwise noted, all Pantone color references that appear in the magazine are 
taken from the Pantone solid to process guide coated. All visuals placed in posi-
tion and separated electronically. Output direct to plate at 150 lpi at RR Donnelly 
& Sons Co. All rights reserved.

Printed in the U.S.A. using soy-based process color inks.

6  DynamicGraphics

APRIL/MAY 2004 - VOLUME 9 NUMBER 2

28
38

48

44



difficult?
buying printing has to be

Think

We pride ourselves on being Easy To Do Business With.

Find out why thousands of your colleagues (and competitors!)

trust us with their full-color printing needs.

Think Again!

w w w. p r i n t i n g f o r l e s s . c o m
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Given the business we’re in, it shouldn’t be surprising that few  
 things in life have more associations for us than print and its 
handmaidens—books, magazines, newspapers, letters, words, 
and type. From our earliest memories of being read to aloud by 
parents and teachers, to the thrill of seeing our own names in 

print for the first time (as Byron pointed out, it hardly even matters what one’s 
name appears in, as long as it’s there), to receiving the sheepskin from alma 
mater U., we virtually lead our lives in print.

Print is enjoying a return to favor, predictions of its demise having proven 
more fleeting than the dotcom boom. And the instrinsic beauty, portability, and 
enduring qualities of type and image on paper ensure that print will be with us 
into the distant future.

Today, the landscape of print—especially in materials and technology—is 
changing fast. Designers seeking to master the medium have more to learn than 
ever before. Color management is a good example. Color consultant Michael 
Jahn, whom many of you caught in Dynamic Graphics Training “Color Talks” 
seminars last year, kicks off the first of a series titled “6 Steps to Better Color” on 
page 28.

Print speaks to us in many voices in this issue. Alyson Kuhn covers the entire 
spectrum of print from A to Z, beginning on page 48, with contributions from 
top designers and tips to make your print work dazzle. Because not all print proj-
ects come with ample budgets, Sheree Clark explores high value/low cost special 
effects on page 44. 

The purpose of this issue is to provide you with tools, tips, and technologies 
that make you look good … in print, of course. Let us know how we’re doing.

FROM THE STAFF

Tom Biederbeck, editor

P.S. Enter our new reader response 
contest and you can win a copy of Doyald 
Young’s limited-edition book, The Art of 
the Letter, published by Smart Papers.
See page 12 for details.







DYNAMIC GRAPHICS TRAINING
www.dynamicgraphics.com/training 888.698.8545

TRAINANDGAIN

Stayon the right course with 
Dynamic Graphics Training!
OS X Transition: A Survival Guide $295
Instructor Ann-Marie Concepción helps you flip the switch from friendly and 
familiar OS 9 to complicated and scary OS X. If you're a designer or design 
manager, who's nervous about making the OS transition, this course is for you.
Learn the new font management system and which font management programs
work best. Get examples of how the system works in both Jaguar (10.2) and
Panther (10.3). Classes offered in Long Beach CA, Washington DC, Chicago, 
Seattle, Dallas and New York.

Transitioning to Photoshop CS $295
Start with a look at what has not changed in Photoshop CS—powerful editing 
tools and basic appearance. Then move into what's new for designers—layer
comps, creating your own keyboard shortcuts, combining filter effects, new 
typography features and using type on a path. Rich Harris explores the powerful
changes Photoshop CS has for digital photographers before closing with a 
penetrating look into what you can do with this dynamic new version. 
Classes offered in Dallas, Washington DC and Chicago.

Typography Two $595
Build on your knowledge of typography with this type-intensive design 
workshop. Great typographic skills are a prerequisite for any top job in 
graphic design today. Ina Saltz helps you expand your type vocabulary, 
sharpen your type skills and become confident and fluent in the use of type 
as a powerful tool for communication. Classes offered in Chicago and Dallas.

Using Your Wacom Tablet Effectively in Photoshop $295
Using Your Wacom Tablet Effectively in Photoshop starts with the basics in 
both Photoshop 7 and Photoshop CS. Rich Harris covers descriptions of the 
21 pen-enabled Photoshop tools, the different brush settings available and 
the different ways a Wacom pen interacts with Photoshop. But that only 
scratches the surface! It’s jam-packed with information. Classes offered in 
Dallas, Washington DC and Chicago.

Mention this ad when you sign up and receive a 
FREE image CD with 150 photos and illustrations!

FREE CD includes:
• 70 high-resolution, quality royalty-free photos
• 70 illustrations (eps & jpg formats) in full-color
• a media mix of PowerPoint templates, sound effects, 

music and motion graphics.

For more class offerings, information and additional dates, visit
our Web site or call our customer service representatives at the
number below to order a 2004 catalog.
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LETTERS
Creative Feedback

In “Color on Call” in the Feb/March 2004 
issue (page 31), you have a sidebar on patterns. 
It references the Auguste Racinet: Historic 
Ornament (Vol. 1) CD. Where can I purchase 
it? Do you have ideas about CDs that have 

great vintage and modern patterns that are
royalty-free? 
Ken Camner
La Canada, Calif.

With regard to the Auguste Racinet: Historic 
Ornament (Vol. 1) CD, you can contact the publisher: 

The Classic Archives Co.
3 West Rocks Rd.
Norwalk, CT 06851
Tel 203.847.0930
Fax 203.845.0679

Visit the Creatas website (www.creatas.com) and 
search under “art patterns” for six pages of royalty-
free patterns. Another great resource is the book 
1000 Patterns: Design Through the Centuries 
by Drusilla Cole, editor. $29.95, Chronicle Books, 
www.chroniclebooks.com.

Looking for logos
Do you have an index to articles or can articles be 
searched on your website? Specifically, I am looking 
for articles about logos.
Mary Meyer
Roseville, Minn.

Sorry, but we don’t have a subject index to articles in 
past issues. A table of contents for each issue back to 
November 2002 (Volume 7, Number 5) can be found 
at www.dynamicgraphics.com/dgm. Beyond that, we 
suggest you check out past Makeovers issues, which 
often feature logos. Also, logos are prominently featured 
in our “Real World Solutions” department, which 
appears in nearly every issue. Finally, an excellent 
resource for logo examples and ideas is David Carter’s 
The New Big Book of Logos, $29.95, Harper Design 
International, www.harpercollins.com. 

Send your tips
We want your best 
design tips (including 
software quickies and 
low-budget solutions). 
E-mail tips or letters 
to slane@dgusa.com. 
We reserve the right 
to edit letters for clar-
ity or space.

Color search
I love your magazine. 
I recently subscribed 
because I especially 
love the colors sug-
gested. It’s great! But 
you never say what 
kind of Pantone you 
are describing. The 
numbers usually cor-
respond to the kind of 
Pantone book (coated, 
uncoated, pastels, 
etc.). Can you please 
specify the Pantone 
extensions for the 
numbers?
Karen Felzener

Thank you for your 
suggestion. Unless 
otherwise noted, all 
Pantone color refer-
ences that appear 
in the magazine 
are taken from the 
PANTONE solid to 
process guide coated . 
We’ve now included a 
note to that effect in 
the Production Notes, 
page 6.

Share your INSIGHTS,
win stuff!

Never underestimate the power of collective 
wisdom … and who has more of it than DG
readers? Here’s a way to share your design 
insights and be rewarded with cool stuff.

This is the deal. Each issue in this space, 
we’ll pose a question relating to the art and 
business of design, and invite you to respond. 
We’ll choose the best responses and publish 
them here, and the reader who provides the 
top response will receive a free design book 
(and we’ll throw in a surprise or two, too!).

This is the prize. Renowned for his ground-
breaking typography and logo designs, 
Doyald Young has teamed up with Smart 
Papers to produce an exclusive book, The Art 
of the Letter. This limited-edition volume is 
packed with insights into the creative pro-
cess, chronicling Young’s work for General 
Electric, Prudential Financial, and others.

There are only two ways you can get a copy 
of The Art of the Letter :
1. Attend one of the lectures Young will give 
in 2004 on his 25-city North American 
tour, sponsored by Smart Papers and the 
American Institute of Graphic Arts (contact 
your local AIGA chapter or Smart Papers at 
513.869.5288 for more information).
2. Answer this question and win!

This is the question.
How do you reward or recognize a 
valued supplier?*

Send your response to:
Marcy Slane, Assistant Editor
Dynamic Graphics magazine
6000 N. Forest Park Dr.
Peoria, IL  61614-3592
e-mail: slane@dgusa.com

* See “Design Dynamics” on page 15 for a 
related article. 



STUDIO PAPERS
Starwhite®

Fox River Select®

EverGreen®

HOUSE PAPERS
Sundance®

Howard® Linen
Coronado® SST
Capitol Bond®

When you see the fox, you’ll see 
inspiration. From our extraordinary line of House and 
Studio papers to the endless possibilities of Special Make papers, Fox River offers you 
the perfect creative playground. With a myriad of colors, textures, weights, and finishes, 
your creative palette is infinite.

So look to the fox when you’re looking to break beyond the boundaries. When you’re looking to 
let your imagination soar. When you’re looking to turn a dream into reality. Because once you’ve 
seen the fox, nothing else will do.

Post Office Box 2215 | Appleton | Wisconsin 54912-2215 | 1-800-558-8327 | www.foxriverpaper.com
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DESIGN DYNAMICS |  Sheree Clark
Ask the Experts

Share the Glory—Value Your Vendors
Appreciating your suppliers is
an art that pays dividends.

While efficient processing of bills—the industry 
norm is net 30 days—is a minimum expectation, 
there are plenty of good reasons to be more than a 
“prompt payer” to your vendors and the people you 
outsource to. Here are a couple:

• Good vendors save you time and money. Your 
best suppliers are those who see themselves as 
partners in your business. For example, I recently 
had a printer call my attention to an unused area 
measuring 8 x 38 inches on a print run. This area 

was large enough to accommodate a variety of 
other items my client would not have been able to 
afford otherwise, making a win/win situation for 
all. Another vendor has given our staff tips and 
tricks that make our projects go more efficiently 
during the production process.

• Vendors can be a source of referral and 
information. Word of mouth is a valuable pro-
motional tool in any industry, including ours. 
Some of my best new client leads have come from 
suppliers. Because they know us and how we con-
duct ourselves, suppliers are a credible as well as 
infl uential source of information for potential cli-
ents. Likewise, vendors may have an inside track 
on industry news—or even a job opening—that 
they’ll gladly share with those they consider val-
ued business partners.

Q
Recommended 
Resources
The Value Profi t Chain:  
Treat Employees 
Like Customers 
and Customers Like 
Employees, by James 
L. Heskett et al, $55, 
Free Press, 2003, 
www.thefreepress.com

Business Etiquette 
& Professionalism, 
by M. Kay duPont, 
$11.16, Crisp 
Publications, 1998, 
www.amazon.com

A speaker at a conference I
went to talked about “vendor 
relations.” Isn’t paying on

time good enough?
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• Ask for criticism. No one likes to be critiqued, 
and most people don’t go looking for criticism, 
but you should. Just as you have “post-mortems” 
with your clients after completing a project, you 
should approach your vendors for suggestions. 
Asking for constructive criticism can yield valu-
able information. How can we do better next 
time? What can we do to make your job easier? 
Sending art that’s truly press-ready (bleeds, 
images, fonts, etc.) saves time and prevents 
confusion—which is important if the project is 
under pressure. Even something as simple as how 
fi les are formatted can affect the workflow for 
your vendors.

• Be understanding. Even in the best of relation-
ships there are bound to be disappointments. 
When a vendor screws up, be reasonable and gra-
cious in your request for a remedy. Share in the 
bad times just as you shared in the good. Find 
ways for a win/win, even if it means a compro-
mise on your part, even if you were not at fault. 
Think long term!

In short, treat vendors like clients. When you’re 
going outside for any product or service—from 
paper to printing to creative services—you’re depen-
dent on others to make your livelihood or your 
job possible. While it’s true that “clients are your 
lifeblood,” so too are trusted colleagues. Not only 
will showing sincere appreciation place you among a 
favored minority, you’ll fi nd that “Do Unto Others” 
is indeed gold. g

So how do you leverage this potential asset and be a 
valued client to your vendors? The obvious answer is 
rooted in the Golden Rule. Some specifics:

• Be truthful. We’ve all been on the receiving end 
of the “fake deadline,” or the client who makes 
unnecessary demands. The reality is that if we’re 
all up-front about when we really need some-
thing, or what the real project parameters are, we 
will all be less stressed. Trust that your vendors 
will come through for you. If they don’t, fi nd 
ones that will.

• Share the credit. As designers we are usually 
front-line with the end-user or client. When a 
project delivers on time and looks great, we get 
the kudos. While it may not be necessary to 
attribute a supplier for his or her work outwardly 
to others, at the very least we can and should 
acknowledge exemplary work to those respon-
sible. Send a copy of the clients’ congratulatory 
note, buy a duplicate award, recommend your 
supplier to others. Share the wealth.

• Say thanks. Typically it is the salesperson that 
takes the customer to lunch. But what if once 
in a while you were to turn the tables? Did your 
outside copywriter pull an all-nighter? Did the 
paper merchant move mountains to get a special 
order on time? Did a printer show you a shortcut 
you’ll use in the future? Why not have a vendor 
appreciation program? Even informal acknowl-
edgment can go a long way in encouraging 
people to continue to work hard on your behalf.

One-Minute Workshop

Softening edges
To create a subdued look 
in Photoshop:
1. Draw a path around the 
image. Save the path.
2. Make the path a 
selection and delete the 
background.
3. Choose Select > 
Modify > Border. Set 
width to 3 pixels.
4. Choose Select > 
Feather and set radius
to 1 pixel.
5. Choose Filter > Blur 
> Gaussian Blur and set 
to the desired result (we 
used 4 pixels).

Before

After

Original

More Resources
The Etiquette Advan-
tage in Business: 
Personal Skills for 
Professional Success, 
by Peggy Post and 
Peter Post, $35, 
HarperResource, 1999, 
www.harpercollins.com

True Professionalism: 
The Courage to Care 
About Your People, 
Your Clients, and Your 
Career, by David H. 
Maister, $26, Free 
Press, 1997, www.the 
freepress.com

Sheree Clark (sheree
@saylesdesign.com) 
is managing partner 
of Sayles Graphic 
Design in Des Moines, 
Iowa; an author and 
speaker on organiza-
tional and business 
issues; and owner of 
Art/Smart Consulting, 
which provides self-
promotion and busi-
ness strategies to cre-
ative professionals.







The Big Brand Theory.

CRE ATASOUR SPONSORS

Creatas and The Art Directors Club present
a half-day seminar, in three cities, with presentations on

Brand Planning, Making a Mark and Realizing a Brand Strategy.

APRIL 29, 2004
LOS ANGELES

APRIL 22, 2004
NEW YORK

APRIL 8, 2004
CHICAGO

For more information or registration, call toll-free 888.698.8545.
www.creatas.com

PRESENTERS:
Alina Wheeler Learn a disciplined process for
managing a brand’s perception using fundamentals,
ideals, processes and trends. 
Design Director/Author, Designing Brand Identity: A
Complete Guide to Creating, Building and Maintaining
Strong Brands.

Steff Geissbuhler Shows and tells how his firm uses a
six-step process to design marks we know and recognize.
Partner & Principal, Chermayeff & Geismar, Inc.

Tom Birk Presents a case study on the effective and
budget conscious launch of the MINI Cooper brand.
Vice President, Director of Strategic Planning and
Research, Crispin Porter + Bogusky.
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WORKING SMARTER | Tracey Turner
Success by Design

Ready, Set, Recover
With the recession officially over, 
are you prepared for an upswing?

As the economy gains momentum, 
graphic design professionals are breath-

ing a deep sigh of relief as they 
anticipate more creative projects 
and, most important, jobs. No 

wonder optimism is in the air: Companies that had 
postponed major marketing campaigns for years are 
now moving forward. Lean advertising budgets have 
been augmented, and hiring activity is slowly but 
steadily increasing.

With such a positive outlook, it’s tempting to
uncork the champagne and envision a return to 
pre-recession “business as usual.” But in the new
economic climate “business as usual” has yet to be
defined. The drawn-out downturn had a major 
impact on the advertising and marketing industry. 
Companies across the board significantly altered their 
strategies to adapt to challenging circumstances, and 
many of the changes are here to stay. Following are 
some ideas for getting ahead and trends to expect as 
the economy shifts gears.

Speedy deliverables
Eager to take advantage of improving consumer 
confidence, many companies are focusing on swift 
delivery to market. Time wasted may mean oppor-
tunities lost to competitors. As a result, firms are 
seeking designers who can deliver fast turnaround.

Businesses also will be moving more quickly 
as they hire creative freelancers for projects. Now is 
the time to make sure your portfolio is current and 
streamlined. Our research shows hiring managers 
expect to see an average of 11 pieces in a creative 
professional’s book. Any more than that may be over-
kill. Also, be sure to have a solid list of references on 
hand—people who can rapidly respond to inquiries.

An eye for quality
Luxury goods are in style, and so, too, is high-
end graphic design. Having realized that bargain-
basement creative leads to projects that never make 
it off the ground, companies are more willing to 
devote dollars to outstanding design. However, 

businesses must be convinced they’re getting what 
they pay for; expectations are higher than they were 
pre-recession. Companies may be developing their 
first full-scale marketing campaign in years, and 
there’s greater pressure to make an impact. To land 
top-dollar clients, show specifically how your work 
helped drive business.

Industry specialization can also be critical to a 
company’s decision to hire you. Firms that hired too 
many “jacks-of-all-trades” (and masters of none) have 
realized the value of specific expertise. If you’ve been 
marketing yourself as a general designer or deeply 
discounting your services, you may want to focus on 
core competencies and repackage yourself as a high-
end expert in an area of specialization.

Steady salaries
While firms may be willing to devote more mar-
keting dollars to design, they did learn during the 
recession that they can pay most industry profes-
sionals less. Thus, starting salaries for full-time posi-
tions such as traffic managers and web production 
artists aren’t likely to climb to pre-recession levels. 
Agencies in particular have been able to hire quali-
fi ed people at reduced rates.

That’s not to say that you shouldn’t approach 
your manager for a raise, especially if you’ve taken on 
substantially more responsibility—many firms will be 
increasing compensation levels in hopes of keeping 
top performers. Just don’t expect a windfall.

Emphasis on employee retention
Most managers are concerned about losing good 
people as the job market improves. Savvy supervi-
sors have already begun meeting with staff members 
to discuss what they can do to keep key players on 
board. While a big raise might not be in the cards, 
perks such as a flexible schedule, opportunity to 
work on more high-profi le projects, a better job 
title, nicer office, subsidized training, or added sup-
port staff are all possibilities.

If you’re suffering from burnout or are bitter 
about management decisions made during the down-

Your career toolkit:
Here’s a checklist 
of tools you’ll need 
to take advantage 
of new opportuni-
ties as the economy 
improves:
• Updated, stream-
lined portfolio with 
10–12 of your best 
pieces
• Work samples 
housed online so
prospective employ-
ers can review your 
work quickly
• Updated resumé 
and professional 
biography (preferably 
available online)
• Reference list with 
three to fi ve easily 
accessible profes-
sional contacts
• Salary guides con-
taining the latest 
compensation data 
to use when negotiat-
ing pay. The Creative 
Group provides an 
annual Salary Guide. 
Call 888.846.1668 to 
request one.
• Subscriptions to 
industry magazines 
such as Adweek and 
other business jour-
nals. These often pro-
vide information on 
fi rms that are expand-
ing and hiring.
• High-quality sta-
tionery for writing 
thank-you notes to 
networking contacts, 
prospective employ-
ers, and clients
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turn, it may be tempting to take another 
job as soon as you get the chance. But con-
sider your situation carefully before making 
a decision. If you have weathered several 
rounds of layoffs, you are probably highly 
valued by your company, which means you 
have some leverage. By requesting changes 
that would enhance your job satisfaction, 
you may be able to create a more gratifying 
role within your firm.

New skills in demand
Some specialties will be in particular 
demand in a growing economy. For exam-
ple, increased anti-spam legislation and 
the use of spam fi lters will prompt many 
companies to refocus on direct mail, which 
will result in increased opportunities for 
direct marketing specialists.

Firms will give prominence to ethnic 
marketing as they try to reach growing 

demographic groups. There will be a greater 
need for creative professionals who special-
ize in Hispanic and Asian markets, among 
others. Advertising for large upcoming 
events, like the Olympics and the U.S. pres-
idential election, will also fuel creative jobs, 
particularly on a project basis. Agencies that 
land these contracts must staff quickly, so 
keep your eye out for opportunities.

More project work
Businesses that experienced cycles of over-
hiring followed by layoffs aim to avoid 
falling prey again. Managers also found 
they could accomplish their objectives with 
leaner teams, and they may never return to 
former staffing levels. To accomplish objec-
tives without adding to the headcount, 
firms are relying more heavily on project 
professionals during peak periods. If you’re 
interested in a freelance career, this is an 
opportune time to pursue one, as more 
companies are moving to this strategic 
staffing model.

While your professional prospects may 
not change overnight, they can improve 
significantly over time. By keeping up with 
current trends and being ready to capitalize 
on them, you’ll be positioned to ride the 
wave of economic recovery.   

Tracey Turner is executive director 
of The Creative Group (www.
creativegroup.com), a specialized 
staffi ng fi rm that places creative, 
advertising, marketing, and web 
professionals on a project basis. 
[Editor’s note: This will be Tracey’s 
last column for us. We will miss 
her contributions.]
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High resolution
stock photos and
original artwork

Exceptional 
design quality

Logo design
artwork in
vector format

Fully customizable layout
file in QuarkXPressTM, Adobe
InDesign®, PageMaker® 
and Illustrator®

Press ready files, suitable
for offset printing or
digital color copying

StockLayouts high-end graphic design templates,
for users of professional layout and graphics
programs, provide fast and affordable solutions 
for producing exceptional marketing materials. 
The StockLayouts template library is packed with
brochures, newsletters, postcards, stationery,
menus, ads and more. View designs and download
our free sample template today.

Headlines and
advertising
copy content

www.stocklayouts.com

1-877-833-3305

Anatomy of a Template

Templates starting at $39

Royalty-free license. Use
layouts and artwork as
many times as you like
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the feel of your finished piece printed on Centura is more substan-
tial and impressive.

Responsibility—Stora Enso is the world-class leader in sus-
tainability and corporate and social responsibility. 

Logistics Service means our merchants span North America 
and our papers are available where and when you need them. Our 
dedicated sales, customer service, and technical service people are 
another part of the Stora Enso equation for success. 

The powerful Resources are here for your benefit. Research 
and development for innovative new products, technical service, 
and sales people offer you continual support, and our financial 
strength keeps us in the forefront of the paper industry. 

Last and of course not least is 
Centura’s Print Quality. Combine its 
superlative printability with its non-
stop runnability and you’ll have print-
ers, corporate end-users, and designers 
dancing across the pressroom floor in 
harmonious print euphoria.

The Stora Enso Centura 100% 
Premium brochure concludes with a 
listing of indigenous pies of North 
America and a state and province 
listing, with phone numbers, of mer-
chants to service you. 

ADVERTISEMENT
Stora Enso

Stora Enso’s bold Centura 100% Premium brochure illustrates 
the real deal on premium papers. This brochure demonstrates 
with informative content and outstanding printing what sepa-
rates Centura from the papers that wish they were Centura. The 
brochure demonstrates how using Centura can help the designer, 
corporate end-user, or printer position their products and/or ser-
vices as the premium brand within their business segment.

Stora Enso illustrates the eight critical attributes that a 
paper—and its manufacturer—must deliver in order to be called 
premium. 

Appearance—Centura’s carefully calibrated color styling and 
brightness level were conceived to allow users to fully capture the 
complete color range of their artwork and the feel and look they 
desire in their printed material. It delivers the level of brightness 
and shade that is preferred by designers and printers across the 
country. 

Our Range of finishes is the envy of the paper world. It has 
the slickest gloss, silkiest silk, most exciting dull, and flattest matte 
surfaces for your premium creative efforts. 

Our Variety of weights, finishes, and sizes come in sheetfed 
and web rolls and are available in many cases the next day. 

Our high Performance level is achieved by consistent manu-
facturing quality and surface smoothness and stiffness properties. 
Centura’s smooth surface and stiffness keep the dots sharp, solids 
and tints even, and the sheets feeding and the webs rolling. Plus 

For more information and a Centura 100% Premium brochure, contact Stora Enso at 800.322.7377
or visit Stora Enso’s website at www.storaenso.com/na.
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As a leader among independent non-
profit organizations, the Jane Addams 

Resource Corporation (JARC) needs 
to communicate its message of out-
standing community service for 

the Chicagoland area. JARC’s Director of Training 
Kathleen Dowling acknowledges the limitations of 
the current JARC identity materials.

Nearly all of JARC’s promotions and publica-
tions focus on the metalworking aspect of its job 
placement program. Although metalworking is an 
important and successful part of its efforts, JARC 
wants its logo and materials to represent its labors in 
other areas of community service.

JARC provides training to unemployed and 
low-income workers on a wide range of production 
machinery. The company also offers economic and 
human development services to local businesses, stu-
dents, and community members. Participants have 
access to business support and career services, advo-
cacy, workers’ advancement committees, and math 
and literacy programs. 

The current look, says DG art director Kathie 
Alexander, is too inconsistent. “You’d never be able to 
tell that all of these materials are from the same orga-
nization,” she comments. “The logo, colors, fonts—
everything keeps changing. An agency as established 
as JARC should have a recognizable look.” Her 
redesign conveys an established, consistent, and 
contemporary look. 

The wide spectrum of services provided to the 
community now appears under one banner, defining 
JARC’s mission. The focus on community has always 
been the best approach for this all-encompassing 
nonprofit leader. As Dowling notes, “We attribute 
our success to our ability to stay in constant touch 
with local residents and businesses.”  

“I thought Chicago’s cityscape would best 
represent the community services JARC provides,” 
Alexander explains. The end result—a uniform iden-
tity for a corporation which has consistently served 
its community for decades.

REAL-WORLD SOLUTIONS 
Design Makeovers from the Pros 

Community Creations
A neighborhood-centered
nonprofit gets focused 

1. Primary concerns
JARC’s materials 
employ various identi-
ties, making it diffi cult 
to determine the orga-
nization’s mission.

2. Original logo
Although the 7-year-
old gear logo once 
made sense, “We 
need a fresh look to 
refl ect the fact that 
we are working with a 
variety of industries,” 
JARC’s Kathleen 
Dowling explains.

3. New logo
The Chicago cityscape 
represents the all-
inclusive nature of 
JARC. “The original 
logo looks forced, 
squeezing three differ-
ent concepts into one 
identity,” notes DG ’s 
Kathie Alexander. “I 
focused on the one 
element they share—
community.”

4. Fonts
“I chose Impact for 
the headings because 
bold sans-serif fonts 
make a statement,” 
says Alexander. “For 
the logo and text, 
I used Sabon. Serif 
fonts have an estab-
lished feel.” (Available 
at www.fonts.com.)

5. Colors
Alexander chose a 
palette with a corpo-
rate, urban feel.

1

2

3
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Resource Corporation

JANE
ADDAMS

Resource Corporation

JANE
ADDAMS

5 C100
M25
Y0

K50

C8
M0
Y9
K19

C0
M0
Y0

K100

4 Impact

Sabon MT Regular

Sabon MT Italic

Sabon MT Semi Bold
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11. Helping the images
Sometimes, as in 
the case of JARC’s 
original photography, 
images need some 
help. Take our advice:
1. Always zoom in on 
the fi nal shot when 
photographing—don’t 
shoot the whole room 
if you’ll only be using 
the guy in the corner.

2 . Cropping is good. 
Just as a writer edits, 
a designer must weed 
out unnecessary 
material in images.
3. When silhouett-
ing an image (using 
a clipping path) 
always soften your 
edges. See how to do 
this in “One-Minute 
Workshop,” page 16.

7

8

9

6

inside

back

10
11

9. Image selection
Black-and-white 
images of each service 
can be printed along 
the left-hand side in 
JARC’s new design.

10. Black printing
Any division of 
the Jane Addams 
Resource Corporation 
is now able to print 
its own service bro-
chures, newsletters, 
or stationery. Black-
and-white text keeps 
print costs down, but 
the materials still look 
professional with the 
two-color logo, name-
plate, and borders.

6. Preprinted shell
By preprinting two-
color borders and the 
nameplate, JARC can 
cut back on the cost 
of printing. Brochures 

7. Nameplate
Titles of brochures, 
newsletters, or any 
printed materi-
als can be easily 
changed in the 
nameplate. Since the 
look stays the same, 
JARC strengthens 
its identity.

8. Quotes
Success stories 
or quotes from 
participants help 
build the organiza-
tion’s reputation 
for achievement.

for any of its services 
can now be com-
pleted in-house in 
simple black ink for a 
professional, stream-
lined result.

front

11
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PAPER EXCHANGE 
DG Promotion

Paper Swatch Watch: 
Hot picks for your next project

Neenah Paper
800.558.5061, ext. 5
www.neenahpaper.com/speakwithus/

StoraEnso North America
800.322.7377
www.storaenso.com/na
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Smart Papers
800.443.9773
www.smartpapers.com

Gilbert Paper
800.445.7329
www.gilbertpaper.com 
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Wausau Papers
www.wausaupapers.com

Fox River Paper
800.558.8327
www.foxriverpaper.com



photis.com
Rights Managed Stock Photography

Exclusively available
at picturequest.com 

950575 / Howard Pyle IV / Photis / PictureQuest 
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We’ve all been there: You 
liked the way it looked on 

your monitor, but you just 
printed it, and the colors don’t 

match. You wonder: Which one 
is right? Chances are—you discover later when the 
press sheets show up on your desk—neither was cor-
rect. No one seems to be able to explain it, and when 
they try, their answers match less than the colors.

What’s the problem? What can be done?
For the next six issues, color expert Michael 

Jahn will describe what sort of animal color is, and 
what it takes to tame it. His six steps to better color:
1. Understand your elements
2. Set up your system
3. Appeal to your applications
4. Monitor your monitor
5. Prove your printer
6. Perfect your PDFs

Part 1—Understand your elements
It’s not typical to begin an article with an apology, 
but you’re owed one. You should not have to worry 
about managing color. Well, you do. Sorry.

You don’t have to worry about managing your 
computer keyboard. It just works. You press an E,
you get an E, not something that looks like a cross 
between an E and some other character.

Unfortunately, that’s not how it is for color. 
Capturing and reproducing color accurately is tricky 
business. Just go into your local sports bar and look 
at all the TVs. You’ll notice that the same game from 
the same satellite feed displays very different colors. 

There are big advantages to having predictable 
color across monitors and output devices. Designers 
need a color page to be reproducible on a variety 
of technologies and with consistent results. This is 
achievable if you set up your system properly and 
apply—ta dum!—color management.

Before we explore what color management is 
and how you can use it, let’s look at how color “hap-
pens” in a digital environment.

Digital images are made up of tiny squares of 
colors called pixels, and each pixel is “described” 

6 Steps to Better Color—Part 1
To build a color-managed workflow, 
start by understanding the basics.

COLOR MANAGEMENT |  Michael Jahn
6 Steps to Better Color

using a set of color values (see center column). There 
are several different ways to “define” color:
• Additive—Adding more colors of light yields a 
lighter color.
• Subtractive—Adding more colors of ink yields a 
darker color.

A banana is yellow … when it’s ripe, any-
way, right? Not necessarily. Want proof? Take your 
banana in a closet and close the door with the light 
off. What do you see? Nothing. Now, if you had 
an image of a banana displayed on your computer 
monitor, you could see that in the dark because the 
monitor is adding light to the room.

You need light to reflect off objects in order 
to see them. Different objects absorb (or subtract) 
certain wavelengths of light and reflect others. That 
creates what we perceive as color.

Here’s the bottom line for color management 
in a digital environment: To have colors appear the 
same on different devices, their color values have to 
be altered or transformed for each device. For a color 
to match on both a computer display (using RGB 
light) and a color printer (using CMYK inks), you 
apply completely different approaches. This is done 
with tables, equations, and other “tricks.”  On your 
computer, it’s accomplished by software that converts 
the color values.

To better understand the concept, here are a few 
basic definitions:
• A color is represented by numbers. A set of 

numbers for a given color is a color value. The 
numbers are different for different color spaces—
RGB, CMYK, etc.

• The numbers refer to a specific profile for a spe-
cific device. Just like the human face, each device 
has its own profi le.

• The profi le is the reference that gives meaning 
(an expression of the color) to the numbers.

• When the image is transferred from one device to 
another (from the source to the destination), the 
reference changes.

• When transferring the image, it is necessary to 
change the numbers so that the meaning (the 
expressed color) remains the same.

Color values
Colors are described 
with values—a group 
of numbers—just 
like distances are 
described in numbers 
of inches, meters, 
and so forth. For 
example, a color 
can be described as 
Red=153, Green=255, 
Blue=204. So what 
does that mean? In 
RGB color space, such 
as is used on a moni-
tor, that “means” a 
light blue color like 
the dot below. To 
express the same 
color in a CMYK color 
space—used in four-
color lithography—the 
numbers would be 
Cyan=51, Magenta=0, 
Yellow=37, Black=0.

Say we send the same 
color values to two 
color devices, for 
example, two moni-
tors. If those moni-
tors display different 
colors, then to get 
matching displays we 
have to send different 
numbers to one of the 
monitors so we get 
the same results.
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• The operation of changing the numbers is color 
conversion. It can be carried out in various ways, 
either within the image processing application 
(say, Adobe Photoshop) or, if the destination is a 
printer, during the printing phase … even within 
the printer itself.

• Color conversion is carried out by a piece of 
software called the color engine. Profi les and 
color engines may be in the computer’s appli-
cations or in the computer’s operating system 
itself. In Macintosh OS, color management is 
carried out by ColorSync, while in some ver-
sions of Windows it’s carried out by Image Color 
Management, ICM, at the system level.

In this series of articles, we will be looking at taking 
a given source (like a scan of a transparency or fi le 
you create in an application like Adobe Illustrator) 
and transforming it to a modifi ed set of values 
appropriate to different destination devices, like 
your monitor and printer.

How does it work?
Simply this: We simplify the situation by introduc-
ing a fi xed color space. One transform per source 
is all we need to produce a standard, and one trans-
form per destination is all we need to conform to 
each destination.

This sounds kind of technical, but it really is 
simple. We change RGB data displayed on your 
monitor into a type of color that is device neutral, so 
it can be converted for a destination space, like your 
printer. This principle is a major part of what color 
management vendors refer to as device-independent 
color (see center column).

To create a device-neutral definition of a color, 
we develop an ICC profile, a file that describes how 
a particular device reproduces color—that is, the 
device’s personal color space. ICC profiles can be cre-
ated for three kinds of devices:
• Display devices (monitor)
• Input devices (scanner, digital camera)
• Output devices (printer)
A profi le that accurately characterizes a device gives 
you best results in a color-managed workflow.

Coming next issue: Set up your system
In Part 2 of “6 Steps to Better Color,” Michael Jahn 
tells you how to set up your computer and peripher-
als to begin building a color-managed workflow.

The ICC
(International Color 
Consortium) was 
established in 1993 
by eight industry ven-
dors to create, pro-
mote, and encourage 
the standardization 
and evolution of an 
open, vendor-neutral, 
cross-platform color 
management system. 
For more informa-
tion on the ICC, go to 
www.color.org.

Michael Jahn is a consultant for digital
workfl ow system vendors in the publishing
and prepress industry. His expertise is in
PDF, PDF processing, prefl ighting, and
color management.

Color
Management
Engine

Destination
Color
Values

Source
Color
Values

Human eye

Camera (fi lm)

Monitor (RGB)

Print (CMYK)

In this ICC-standard 
rendering of color 
space, the overall area 
shows colors visible to 
the human eye. Other 
color spaces only 
cover portions of the 
visible spectrum.

CMYK

RGB

g
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Ready...Set...Read!
Get the digital edition of Dynamic Graphics magazine with

design ideas for the real world delivered instantly.

Subscribe today to the digital version of
Dynamic Graphics magazine

and get 6 issues for ONLY $36.
That’s 25% off the single copy price!

The digital edition emulates the look, feel and experience
of reading a printed magazine—right on your computer.

YOU’LL ALSO GET DIGITAL ARCHIVES FOR FAST REFERENCE

KEYWORD SEARCH • ZOOM, HIGHLIGHT AND ELECTRONIC NOTES

Try a digital subscription today. www.dynamicgraphics.com/digitaldgm
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ATTENTIONATTENTION
PHOTOSHOPPHOTOSHOP®

JUNKIESJUNKIES
THE MUST-HAVE FIX IS IN!THE MUST-HAVE FIX IS IN!

Photoshop® Fix, a new monthly 
newsletter devoted entirely to 
Photoshop, premiers in May. 
Get 16 pages of tutorials & tips 
by industry experts covering 
Photoshop® tools, filters, and 
effects with easy, step-by-step 
instruction and vibrant full-
color images. 
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Their take. The Blue Ridge Modular 
brochure (above) by Grant Design 

Collaborative is an atypical take on the 
usual promotion. It’s a booklet of pre-perfo-
rated postcards that customers can use. The 

pictures are of the interesting people and background 
behind the company, not the usual in-your-face 
advertising. “Since the piece is such a reflection of 
who the company is and what it stands for, it helps 
promote Blue Ridge in a different light from its com-
petitors,” says Grant’s design director Vivian Mize.

One added benefit of this booklet is that the 
postcards function as likable mini-promotions, reach-
ing out to potential customers with no effort on Blue 
Ridge’s part. “Showing real employees in the piece 
adds to Blue Ridge’s brand personality,” notes Mize. 
“They are real people—honest and hardworking. 
Their product is a direct reflection of who they are.” 
Who doesn’t appreciate a smiling face?

Another advantage is that once the postcards 
have been torn out, Blue Ridge customers still have 
a little book of carpet examples and contact infor-
mation they can keep handy. “We believe that form 
follows function,” Mize explains. “We needed a piece 
that was multipurpose.” 

As an added touch, the binding of this piece 
gives it extra elegance with little expense. The book-
let was simply stapled together, but the top cover 
actually works as the binding and the back cover 
in one. It’s folded over the stapled pages, giving it a 
perfect binding look. www.grantcollaborative.com

MAKE IT YOUR OWN
Thrifty Spinoffs that Inspire

Our spins. Why waste paper? There is so much you 
can do with the classic brochure—it doesn’t have to 
be all promo and no practicality. In addition to the 
inventive postcards from Grant Design Collaborative, 
there are a ton of great ideas out there. We based all 
of our spins and twists on pre-perfed shells by Paper 
Direct (see contact information on next page). 

The Step-Up brochure (opposite page, top), 
presented numerous options. Where a business card 
for the Pure Touch Day Spa would normally go, we 
decided to include a business magnet instead—a 
much less disposable reminder. The shortest insert is 
pre-perfed for the business card (the two together are 
the same size as the longest insert). To magnetize the 
cards, buy a backing and simply stick it on the cards 
once they’re printed. 

For the three step-up inserts (opposite page, 
right), we used the longest one as a price list, the 
middle one for general explanatory information, and 
the shortest one for practical cut-out coupons which 
should increase business. 

We also decided to use a pre-perfed Reply Card 
brochure in an unusual way (opposite page, bottom). 
How about bookmarks? They not only promote 
the Hopscotch Children’s Bookstore and its events, 
but also give customers something they can use and 
remember the store by. An added benefit is that 
bookmarks promote the reading of books, which just 
happen to be what the store sells.

Other twists. Here are 
other ways to use pre-
perfed brochures:

Practical perforation
Put your brochures to good use

g

• To add a personal 
touch to your bro-
chure, it’s always a 
good idea to include 
your business card. 
This Thumb-Cut bro-
chure is perfed with a 
secure card holder.

• Moving and want to 
be sure everybody’s 
got your address? 
This brochure helps 
contacts keep their 
Rolodexes updated.

Thumb-Cut brochure

Rotary Card brochure
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fun for everyone!
Welcome to the Hopscotch Children’s Bookstore! 
Please take a moment to visit our registration 
website at www.hopscotch.com! Exciting things 
happen here, and we invite you to learn more 
about us and our new offerings!

preschool
Preschool Storytime
Thursdays, April 15- June 3: 10 a.m. - 11 a.m.

Spanish for Little People
May 1, 8, 15, 22: 11 a.m. - 12 p.m.

French for Little People
June 5, 12, 19, 26: 11 a.m. - 12 p.m.

Dance! Dance! Dance! Preschool Dance Party
May 29: 4 p.m. - 6 p.m.

Preschool Science
April 24: 4 p.m. - 5 p.m.

school kids
Page Turners
Tuesdays, April 6 - June 1: 7 p.m. - 8 p.m.

Fun With Math: Mathetopia
May 6, 13, 20, 27: 7 p.m. - 9 p.m.

Reading Heroes
May 29: 1 p.m. - 4 p.m.

Word Wizards: Creative Writing for Kids
Thursdays, June 3-24: 6 p.m. - 9 p.m

Make It & Take It
May 1 - 2 p.m. - 5 p.m.

Reader’s Theater
May 21 - 6 p.m. - 7 p.m.

Adventures in Acting
Wednesdays, April 7-28: 6 p.m. - 8 p.m.

Adventures in Acting II
Wednesdays, May 5-26: 6 p.m. - 8 p.m.

teen
‘Zines for Teens
Mondays, April 5-May 3: 8 p.m. - 9 p.m.

Teen Screen: Movies in the Afternoon
Saturdays, April 17-May 15: 8 p.m. - 10 p.m.

Music Censorship in America
May 17: 6 p.m. - 7 p.m.

Babysitting Clinic
June 5: 1 p.m - 4 p.m.

Homework Help
Wednesdays, April 7 - May 26: 6 p.m. - 9 p.m.

Groom Your Room II
May 1: 4 p.m. - 6 p.m.

Teen Scene: Candle Creations
May 8:  1 p.m. - 4 p.m.

Teen Job Fair
June 7: 6 p.m. - 9 p.m.

family
Wacky Sunday
April 4: 10 a.m. - 5 p.m.

Mother & Daughter Bead Workshop
April 11: 1 p.m. - 3 p.m.

Family Storytime
April 18: 12 p.m. - 2 p.m.

Family Funfare
April 25: 5 p.m. - 7 p.m.

Stories in the Park
May 2: 1 p.m. - 3 p.m.

Movies for You
May 9: 4 p.m. - 7 p.m.

Dancing Families
May 16: 6 p.m. - 9 p.m.

Scary Stories
May 23: 6 p.m. - 9 p.m.

Dancing Families II
May 30: 6 p.m. - 9 p.m.

Shell
The Step-Up brochure 
is a sleeve (use your 
best image on the 
cover), three inserts, 
and a business card. 
Slots have been pre-
cut in the sleeve’s 
fold-up card holder. 

Bookmarks
The standard use of 
the Reply Card bro-
chure is obvious, but 
we decided to use the 
perforated columns 
as bookmarks. They’re 
something customers 
might actually keep 
and use!

Shell
The Reply Card bro-
chure is trifold, with 
the right column as 
the tear-off card.

Specials
Guinot Berry Facial

A rejuvenating gentle fruit acid with 

blackberry, raspberry, and black cur-

rent that will help to stimulate cellular 

renewal. This facial will restore supple-

ness, eliminate minor blemishes, and 

add radiance to tired-looking skin.

OFFER GOOD THROUGH MAY 31.

Seaweed FacialDetoxify with purifying algae extracts 

that deep clean and re-hydrate. This 

four-layer treatment will eliminate tox-

ins caused by pollution, rebalance your 

skin type, and revitalize the facial area, 

leaving you with a fresh face for spring.

OFFER GOOD THROUGH MAY 31.

Pedicure
Get your tootsies ready for spring—cold 

winters can be rough on your feet. 

They’ll will love you again after this 

pampering treatment of exfoliation, 

massage, moisturizing, nail shaping, and 

polish. Make your toes happy!

OFFER GOOD THROUGH MAY 31.

Manicure + Pedicure
Cold winters are hard on your hands, 

too. Our manicurists will handle you 

with care with hand massage, cuticle 

treatment, softening cream, nail shap-

ing, and polish. The best decision you’ve 

$15 off

$20 off

$10 off

Pure touch
day spa

410 Spruce Drive, Suite 412

Panama City, Florida 55874

Call for an appointment

879.555.9565

Magnet 
The business card is 
perfed off the short-
est insert. Simply stick 
magnetized backing 
on it to give it a more 
permanent presence.

perf line

cut line

Step-Up brochure

Reply Card brochure

Pure touch
day spa

Get your own
All pre-perfed 
brochure shells 
from Paper Direct, 
800.272.7377, 
www.paperdirect.com.

Stacks
Stacked inserts give 
you plenty of room 
to give a price list, 
general information, 
and coupons.

Coupons
Instead of overload-
ing the customer with 
too much information, 
give them practical 
coupons to cut out.
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COLOR ON CALL 
Trouble-Free Palettes

Tasty: appetizing; savory;
flavorful; delectable

Chances are that at some point in 
your life you’ve had the urge to eat    

   even when you weren’t hungry. What          
could be the reason behind these 
seemingly inexplicable hunger pangs?

Colors conjure different moods and effects on our 
appetites—red inspires people to make quick deci-
sions (think fast food); orange stimulates hunger 
(health food products); green represents freshness 
and growth (salads and other veggies); yellow is 
lighthearted (lemons, bananas); white is clean and 
wholesome (dairy products); brown is natural (energy 
bars); blue is pure (water); and violet is thought to 
reduce hunger (although there are some exceptions, 
like grapes and eggplant). 

Illustrator Cindy Ho understands the correla-
tions, and she enjoys illustrating food, fun, and 
travel: “Food is always interesting. No one gets tired 
of food. But even without it, I like my illustrations to 
look savory. Something you can eat with your eyes ... 
drool over, even.” The color palette she uses—which 
she describes as a “fun, frolic type”—often comes 
from a real-life idea which she then will incorporate 
into an illustration. 

Ho gets inspired by sparks of color in real life—
people watching, window shopping, magazines, cata-
logs, even dreams give her ideas. At the moment, she 
favors “candy” colors and combines them with oth-
ers. One of her favorites is red, as it “gets the point 
across—it’s so showy and dramatic,” she explains. “I 
also love butter yellow—nothing is more innocent, 
sweet, and warm. And different greens together seem 
smart and honest.”
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M100
Y62
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M35
Y85
K0

PANTONE
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M68
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C0
M97
Y100
K50

PANTONE
123

C0
M24
Y94
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g

Photo palettes
This summery pasta 
salad practically 
screams “Eat me.” 
Notice the crisp 
freshness of the veg-
etables, and their 
diverse color medley 
(in reds, greens, and 
yellows). The basket 
of red tomatoes and 
peppers stimulates 
the appetite, and the 
subdued yellows of 
the bread and pasta 
create a light mood.  
Image BXP50102, 
www.creatas.com.

Fresh and natural
Cindy Ho, whose work 
often features food, 
uses a similar palette 
in many of her illustra-
tions—reds, greens, 
oranges, lavenders, 
and other sweet hues. 
“I like taking a boring 
subject and giving it a 
playful twist,” she 
explains. “Colors cre-
ate a mood. They are 
much more emotional 
than intellectual.” 
www.cindyho.net
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Whet their appetite
These fonts can 
reinforce an edible 
theme: Zennor 
(tangy)—sharp, with 
its quick motion and 
points; GarishMonde 
(crispy)—all crunched 
up; Compacta 
(fresh)—clean and 
pure; BlackJack 
(sweet)—emotes a 
luscious, sensual vibe. 
Zennor and Compacta 
from www.fonts.com;  
GarishMonde and 
BlackJack at www.
fontface.com.

Tasty symbols
The pineapple and 
strawberry universally 
represent mouth-
watering sweetness. 
Emphasize color in 
your images, and 
you get your mes-
sage across with an 
appetizing fl air. Try 
oranges and reds to 
make people hungry; 
greens and yellows 
to create a fresh 
look. Image 429010, 
www.creatas.com.

Find your own palette
Take your color guide 
to the fruit market, 
where you can fi nd 
the most vibrant 
and deliciously 
vivid shades. Image 
AA050299PD, 
www.creatas.com.

HEX E9CB32HEX C00046

HEX 6E0717HEX D07527

HEX D8E6ACHEX 6DB340
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Post-it Notes and typeface families have a lot in com-
mon. Both are simple yet elegant solutions to everyday 
problems. It seems like they’ve always been there for us, 
making life a little easier.

While we may think that typeface families have 
been around forever, the truth is the concept, like Post-it 
Notes, is relatively new. Type families weren’t invented 
in the last decade, of course, or even in the last 50 years. 
But when you consider that type has been with us for 
more than 500 years, and that the idea of a typeface 
family is only about 80 years old, the concept is still 
rather young.

The person generally credited with conceiving type-
face families is Morris Fuller Benton, director of typeface 
development for American Type Founders in the late 
19th and early 20th centuries. Benton’s premise was that 
the typefaces would maintain basic characteristics of 
the parent design, but with individual design variances. 

By Allan Haley

Using typeface families to unite elements of complex 
projects is a relatively new idea whose time has come.

family
keep it

in the

Cheltenham, Century, Cloister, and Stymie typeface 
families are just a few of the designs for which Benton 
was responsible.

Benton’s original idea has been modified and 
expanded several times over the years. Type families have 
become larger, more diverse, and well thought-out.

Planning by the numbers
In 1957, Swiss type designer Adrian Frutiger designed 
a new kind of type family. Because Frutiger felt that 
the traditional system of providing names—bold, semi-
bold, semi-bold condensed, and so on—was confusing 
and outdated, he proposed what he believed was a logi-
cal and systematic numbering scheme.

In Frutiger’s system, each typeface was given a two-
digit suffix. The first digit classified the alphabet weight, 
with 3 indicating the lightest weight in the family and 
8 the boldest. The second digit identified the typeface 
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proportion, with higher numbers for condensed designs 
and lower numbers for expanded designs. In addition, if 
the second number was odd, the typeface was a roman 
design; if it was even, the typeface was italic.

Thus, Univers 39 is a very light condensed roman, 
while Univers 56 is a medium-weight italic of nor-
mal proportions. Neue Helvetica and Serifa are two 
more type families that use this numbering system. 
Unfortunately, Frutiger’s idea didn’t take the typeface 
design community by storm, and consequently is prob-
ably more confusing than the naming convention it was 
intended to replace.

Extended type families
There are typeface families that are made up of differ-
ent sub-families. ITC Stone is a perfect example. The 
sub-groups consist of serif, sans, and an informal 
design intended for casual correspondence. Each sub-
group has roman and italic versions in three weights 
for a total of 18 individual typefaces. The three basic 
designs share the same cap heights, lowercase x-heights, 
stem weights, and general proportions. Each typeface, 
however, is designed to stand on its own as a useful 
communication tool. Additionally, any of the faces can 
also be combined easily with others in the family.

Thesis from FontShop and ITC Legacy are two of 
several typeface families made up of sub-families.

Size-specifi c families
Another kind of type family has different designs for 
use at different sizes—ITC Bodoni is such a family. It’s 
comprised of three size-sensitive variants, named Six, 
Twelve, and Seventy-Two. These are designed to imitate 
the subtle yet critical differences in the progressively 
sized metal punches that Giambattista Bodoni created 
for his original fonts. The numerical names indicate the 
point size around which each variant should be set, but 
as with most things typographic, there are no hard and 
fast rules.

FB Californian from Font Bureau and ITC 
Founders Caslon are also size-specific typeface families.

Using typeface families
Typeface families are great instruments to employ in 
extensive or complicated projects. The various weights 
and proportions can be used where basic text, areas of 
emphasis, economy of space, subtexts, etc., are called 
for. Even though the specific faces are different—and 
are doing different jobs—their common design traits 
create continuity and visual cohesiveness.

Like Post-it Notes, the simple concept of a typeface 
family has matured, providing a range of useful tools.

Case study
Matching and mix-
ing typeface families, 
Peterson & Company 
(www.peterson.com)
has created consis-
tent visual identities 
for two college cam-
paigns. Firm principal 

Bryan Peterson says 
careful planning, 
including marketing 
studies and interviews, 
is required to under-
stand a school’s per-
sonality, which then 
can be expressed in a 
typographic style. 

g
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The yellow banner 
running across the 
center of the View 
Book at left almost 
becomes a logo for 
the overall campaign. 
The banner incorpo-
rates one of the signa-
ture typeface families 
in all three pieces: 
Interstate. Interstate 
Regular on the left 
is complemented by 
Interstate Bold on the 
right. Peterson’s Ray 
says the Bold face bal-
ances the larger type 
(MSMC3) in Regular. 

An inner page from 
the View Book, 
at right, employs 
Interstate Regular 
Condensed for variety 
and a more vertical, 
contemporary look.

Two print campaigns—
for Mount Saint Mary 
College and Bucknell 
University—appear on 
the next four pages. 
Each campaign is 
made up of a Search 
Mailer (for mass mail-
ing to potential stu-
dents), a Travel Piece 
(quick info for pass-
out), and a View Book 
(a full-scale informa-
tional brochure).

ABCDEFG
abcdefg

ABCDEFG
abcdefg

Interstate Regular

Octavian MT Regular

In addition to carefully 
blending families of 
typefaces, Peterson 
partner and senior 
designer Scott Ray 
established a simple 
but powerful color 
palette for the Mount 
Saint Mary campaign.

C0
M90
Y100
K0

C0
M29
Y91
K0

C0
M0
Y0

K100
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Text in the View Book 
is in various weights 
of Octavian, a highly 
readable, classically 
infl uenced typeface 
Ray felt harmonized 
well with Interstate. 
He notes that its 
slightly condensed 
quality saves space 
in text sections. Once 
again Ray brought 
the C3 icon into the 
spread for continuity. 
In this case, the cap 
had to be vertically 
stretched to span the 
height of the adjacent 
copy block. Because 
Interstate became 
too distorted when 
stretched that far, Ray 
substituted Triplex 
Condensed Regular 
while maintaining 
a virtually identical 
typographic presence.

The Mount Saint Mary 
Travel Piece functions 
as a visitor informa-
tion guide and helps 
prospective student 
families set up cam-
pus visits. The cover 
(at left) features 
Interstate Regular 
Condensed caps inter-
spersed with photo 
portraits. Some of 
the letterforms were 
stretched to give a 
friendly, playful fl avor.

The spread from 
the same piece (at 
right) incorporates a 
screened-back version 
of the C3 icon, help-
ing to tie this piece 
to others in the cam-
paign. The icon here 
is set in Interstate 
Regular Condensed.
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A campaign for 
Bucknell University, 
designed by Bryan 
Peterson, uses 
Univers, Zurich, and 
Minion families to link 
three print pieces. 
Peterson chose to 
employ both Univers 
and Zurich, two func-
tionally equivalent 
sans-serif families. 
The design of the 
piece afforded him an 
unusual opportunity 
to use slightly differ-
ent characters inter-
changeably between 
the two. Readable, 
elegant Minion com-
pletes the family suite.

The cover of the 
Bucknell View Book 
at left illustrates how 
the designer mixed 
Univers and Zurich 
families to achieve 
specifi c typographic 
effects. “The Power 
of 2” is set in Zurich 
Condensed, while A 
and B are in Zurich 
Black Extended to 
stand out in the
red circles.

On an interior page 
at right, the A and B 
are in Univers 67 Bold 
Condensed because, 
Peterson notes, Zurich 
doesn’t have the exact 
letterforms needed; 
the caps would be too 
small in Zurich.

ABCDEFG
abcdefg

ABCDEFG
abcdefg

Univers 55 Roman

Minion Regular

Peterson says that a 
signature type and 
color approach func-
tions like a billboard: 
“Every time you see 
this combination, you 
know you’re looking 
at Bucknell.” Black 
borders on the pieces 
contain the visuals 
and provide strength.

C10
M100
Y90
K0

C0
M40
Y90
K0

C80
M62
Y15
K15

Identity elements for 
the Bucknell campaign 
are based on math-
ematical formulas. For 
the 2 on the Search 
Mailer cover and else-
where, Peterson chose 
Univers Extra Light 
Condensed and modi-
fi ed it in Illustrator.
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The math theme gets 
a further workout, this 
time with pure visual 
icons and symbols in 
the upper left corner 
of a spread from the 
View Book. The mes-
sage is, “Why settle 
for pie or ice cream 
when you can have 
them both?” says the 
designer. Type in the 
headline (“Conduct 
serious research”) 
is in Univers Black 
Extended to create 
maximum presence 
and impact while 
keeping size down so 
it doesn’t overwhelm 
the page.

Text set in Minion 
with substantial lead-
ing keeps the spread 
open, combining with 
photos for a graphical 
environment that rep-
resents the school’s 
expansive campus.

Centered math sym-
bols balance the 
layout, with A and 
B in Zurich Black 
Extended. The heavier 
face provides pres-
ence so the heading 
can carry the page.

This interior spread 
from the Search Mailer 
emphasizes a central 
theme of the cam-
paign: That Bucknell 
offers the intimacy 
of a college and the 
choices of a university.
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In the world of print there are certainly champagne 
projects. You’ve seen the results when budget isn’t an 
issue: big, beautiful pieces with an array of diecuts, 
embossing, multiple colors, and an assortment of other 
special effects. But what happens when you have more 
ambition than your client has dollars? Is there any way 
to make a “beer” project pop like a cork?

It’s really no secret that the secret to low-cost but 
plush-looking projects is ingenuity. It may be easier to 
produce a nice-looking piece when money is no obsta-
cle. But for most of us, budget is always a consideration, 
often the biggest one in defining design parameters. 
Fortunately, by applying a little imagination and a lot 
of resourcefulness, low-cost pieces can come off looking
like a million bucks.

You want a new Mercedes, 
but your salary steers 
you to an old Yugo. You 
like caviar, but your bud-
get says stick with tuna. 
Champagne taste on a 
beer budget. Who hasn’t 
been there?
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This open house 
self-mailer opens 
via a side perfora-
tion. Inside is a set of 
coasters in a plastic 
bag blind-stitched 
with staples. To bind 
the invitation, creative 
director Damien Wolf 
of OrangeSeed Design 
(www.orangeseed.
com) tried something 
different: With a sew-
ing machine, each 
mailer was stitched 
shut with thread. Wolf 
explains, “To keep 
expenses to a mini-
mum, the piece was 
digitally printed, the 
coasters piggybacked 
onto a client’s print 
run, and everything 
hand-assembled in-
house by staff.”

Creative binding
One of easiest ways to add interest to a 
print project is to use a unique binding 
technique. And while it’s true that some 
special binding processes can quickly add 
to total production costs, there are plenty 
of options that merely look expensive—in 
part because they’re applied outside of 
their usual contexts. Some examples are 
eyelets, grommets, rivets, clips, rings, and 
fasteners. Other options, such as sewing 
or tying, can add textural appeal.

In most cases, the bulk of the expense 
in specialty binding is the cost of labor to 
collate and assemble the project, so having 
access to “cheap labor” becomes impor-
tant. Obvious labor solutions include 
using staff, interns, and willing family 
members and friends (slavery’s immoral, 
but friends will work for chili and beer). 
And many communities have service cen-
ters where people with disabilities work on 
repetitive-task projects at low cost.
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Faux diecutting
While the cost of traditional diecutting has come 
down over the years, for small print runs the addi-
tional expense is often not justifiable. An alterna-
tive is to give the illusion of a diecut, without the 
expense of a die charge. For small or even midsize 
runs where precision is not essential, a hand-held 
punch is an option. Many office supply or hobby 
stores have paper punches available in a variety of 
shapes. As with binding, the most significant—and 
perhaps most controllable—variable becomes the 
labor expenditure.

Another way to give the illusion of a die cut 
is to use straight cuts at varying angles. Clipping 
the corner off a business card, for example, can be 
accomplished with a traditional die, or by simply 
instructing the printer to make an additional straight 
cut at an angle when the card is trimmed out.

Printers often have 
“standing dies” 
created for other 
customers and avail-
able without a tool-
ing charge, like the 
4-inch circle die 
used by Emspace 
(www.emspacegroup.
com) for its New 
Year greeting at left. 
Designer Elizabeth 
Murphy says, “We 
bound this mailer 
with a simple round-
head brass fastener. 
We asked the printer 
to drill the cards for 
easier handwork.”

Using hand punches, 
Adam Lazar (www.
adamlazar.com) cre-
ated the invitation 
below. A cut in the 
envelope reveals the 
red inside. Gluing blue 
paper over the inside 
panel adds color with-
out additional inks.
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John Sayles of Sayles 
Graphic Design (www. 
saylesdesign.com) got 
extra mileage with the 
same die and different 
graphics for the self-
promotion above.

In the stationery pro-
gram for a kitchen and 
bath fi xture showroom 
(left), Damien Wolf of 
OrangeSeed Design 
specifi ed a 11⁄2-inch 
business card—rather 
than the standard 2-
inch—with an angular 
trim off the lower left 
edge. The two trim 
tricks—accomplished 
without a die—com-
bine to create an 
unusual card with 
European style: very 
appropriate for the 
client. All stationery 
components include 
the “notch.” 

A diecut was used in 
the TransUnion bro-
chure, but the cost of 
a pop-up was avoided 
with clever scoring 
and folding—no gluing 
was necessary. 

Use of color
Judicious use of color is another way in which 
designers can make a project appear more high-end. 
While we frequently equate “expensive” with “multi-
colored,” oftentimes a prudent palette can provide a 
better solution, if for no other reason than it stands 
out from the expected. Age-old techniques such as 
specifying a different color paper for each signature 
in a brochure or publication, printing black-and-
white images as duotones, using screen values, etc., 
are so tried-and-true that we sometimes overlook 
them in their simplicity.

Other effects
There are many other methods for adding a little zip 
to a project while still keeping a budget in check. 
Unusual folds (especially those not requiring hand-
work), varying the size of pages, specifying indus-
trial paper such as fi berboard or kraft, pop-ups that 
can be produced in-line without glue ... all these 
options add dimension and interest. With good 
planning, you’ll get that champagne buzz without a 
budget-busting hangover! g
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Alyson Kuhn is a freelance writer whose recent 
projects include the SpecLogix Compendium 
of Paper & Printing (2002, SpecLogix, Inc.). 
She also represents Dickson’s, a specialty 
printer in Atlanta, on the Left Coast, sensing 
the pulse of paper and print on the brink of 
“the electronic almost-everything.”

A tour in 26 letters of the landscape of 
paper & print, today & tomorrow

By Alyson Kuhn

from
print

paper

Cost Plus 2002 Annual Report

Alpha Key: B, D, G, H, I, L, Q, T, X

Design: Turner & Associates, 

www.turnersf.com

Printing: Watermark Graphics,

www.kelmscottconnected.com

Notes: B-fl ute corrugated board was scored 

on press, hand-broken to avoid cracking. 

Three different label patterns taken from Cost 

Plus merchandise. Micro-perforated labels 

applied by hand.
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d
Dimensions
Mechanical art is
two-dimensional, but 
when a piece goes to 
production, it enters 
the Third Dimension. 
Imagine: a sheaf of 81⁄2 
x 11-inch sheets in a 
folder with a half-inch 
box pocket. How big 
should the envelope 
that holds this pocket 
folder be? Depth 
takes up space; scor-
ing and folding take 
up paper. Your printer, 
envelope converter, or 
die-maker is a great 
resource for fi guring 
out the best possible 
proportions and fi t 
within manufacturing 
tolerances. Tip: Make 
sure your triple-digit 
MacDecimals can be 
converted to fractions 
before releasing digi-
tal fi les. Dimensions 
that can’t be mea-
sured on a ruler can 
cause problems for 
die-makers, printers, 
and converters.

Aramark Roadmap Pocket Folder

Alpha Key: B, D, G, H, U

Design: Murphy Design, 

www.murphydesign.net

Printing: Piccari Press, 

www.piccari.com

Notes: “Switchback” appearance 

of staggered inserts reinforces 

career planning theme. Angled 

cuts keep inserts accessible.

a  Acid-free & Archival
These are not, strictly speaking, interchangeable. 
Acid-free paper is made without acid-forming com-
ponents: This is now the norm for machine-made 
papers. Archival paper is actually slightly alkaline, 
to counteract acid on fi ngers, in bindery materials, 
even the air. Archival paper offers an extra level of 
protection, which isn’t necessary unless longevity 
is an issue. “Acid-free” and/or “archival” appear on 
packaging for most scrapbooking papers, accessories, 
and adhesives—anything that might touch photos.

b  Bindery
A print job can take much more time in bindery 
than it spends on press. Example: A perfect-bound 
annual report double-stick-taped into a corrugated 
cardboard cover and sealed with a label. Avoid 
“bindery binds” by asking your printer up-front for a 
(non-binding!) post-press timetable. You can discuss 
the feasibility and cost of an initial partial delivery, 
which may satisfy a client’s immediate need.

c  Color
Offset inks are deliberately transparent, so col-
ors can be built. To get the best “read” on the 
differences between two colors with adjacent refer-
ence numbers, look at their formulas in addition to 
color chips. Color is both refl ective and subjective, 
which is why you can’t ask your printer to match 
ink on press to the toner of your Epson. Ultimately, 
the recipient of your piece won’t know what you 
were trying to achieve chromatically, only whether 
what you produced is appealing and memorable.

Envelopes
An envelope sets the tone for what’s within. Most 
of us sort our mail, seeking something that looks 
promising: a square envelope, a colored translucent 
envelope, a black envelope ... and direct mail design-
ers continue to “push the envelope” for customer 
attention. If you’re designing an envelope that will 
be mailed, you need to plan for addressing (calligra-
phy? label? inkjet?), inserting, sealing, and franking 
(indicia? real postage? electronic stamp?). The USPS 
website (www.usps.com) is the authoritative source 
for rates and regulations. Tip: Swatchbooks may 
show a given envelope as  “available,” which may 
mean “if you have the time to wait and the budget 
to buy a full carton.”



g
f  Fiber
Most commercial paper is made of wood fi ber. The 
fi bers are mixed with water, chemicals, and other 
additives, to make the most consistent printing 
surfaces possible at the most competitive prices pos-
sible. There are more trees in North America today 
than when Columbus landed, but there are also a 
lot of landfi lls. Cotton, which provided fi ber for 
all American paper until the 1870s, is still used for 
high-end paper. Alternative fi bers, such as kenaf, 
are gaining ground. Many mill papers now contain 
a percentage of post-consumer waste; specifying 
recycled paper keeps material out of landfi lls longer.

Grain
The most common designer disappointment about 
grain direction concerns weight. Even a wide, gentle 
score may not prevent paper fibers from breaking 
when a heavy sheet is folded. Scoring with the grain 
is generally preferable (notecards, tri-fold brochures), 
but certain pieces require scoring both with and 
against the grain (pocket folders). The heavier the 
stock, the more fibers, and the likelier it is that some 
will break. Cracking along an unprinted score may 
sneak by, but cracking along a surface covered with 
ink is particularly noticeable because the stock under-
neath peeks through. Paper mill promotions may pro-
vide inspiration, but it’s best to defer to your printer.

H  

Handwork
Generally, the smaller 
the quantity, the more 
handwork you can 
afford. Unlike press-
work—where higher 
quantity means lower 
unit cost—there is 
rarely economy-of-
scale with handwork. 
But a hand-applied 
label, ribbon, or rub-
ber stamp may be just 
the touch to increase 
response or make a 
down-and-dirty press 
release stand out. 
Tip: Present mock-
ups or prototypes 
in both “plain” and 
“garnished” versions 
to your client, show-
ing cost difference per 
piece (rather than for 
the total job).

 i Industrial Papers
Chipboard, kraft paper, corrugated cardboard, 
absorbent papers, “office supply” materials—all have
distinctive personalities and set a visual tone for a 
printed piece. Putting elegant art or high-end print-
ing on an industrial paper provides an eye-catching 
contrast. Tips: Most industrial papers vary in color 
from manufacturer to manufacturer and from lot 
to lot. If you plan to use a substrate for something 
other than its intended purpose, check with your 
printer or converter for a way to test. When spec’ing 
stocks that aren’t distributed through normal paper 
merchant channels, be sure to check order mini-
mums before presenting to a client.

Billy Jack & Dollar Jill

Alpha Key: F, H, T, U, Y

Design: Eroca Brawne, 

Vancouver, British Columbia

Notes: Created as giveaways for 

a gala dinner. U.S. currency folds 

well because of its 100 percent 

cotton content. So “wash and 

wear,” and the cost of engraving 

is already in the materials!

50 DynamicGraphics
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j
Justify
It’s not easy to justify the time and expense of a 
professional proofreader or copy editor, but today 
more and more pieces with strong design and high 
production values are undermined by poor gram-
mar, spelling errors, and inconsistencies. Spell-check 
software is only as good as you make it; add proper 
names, technical terms, and foreign words to your 
e-dictionary. Don’t rely on proofi ng your own work. 
Your eye sees what it expects to see and reads what 
you meant rather than what you wrote.

K  Kiss-Cutting
This is a great way to deal with sticky-back labels or 
seals—a steel die cuts through the paper layer but 
not the backing sheet, so labels peel off easily. Tips: 
Check with your printer before designing. Dies are 
priced by the running inch, so cuts that abut one 
another are the most economical. An elaborately 
shaped sticker may not be “cut-able” with a conven-
tional die; laser-cut dies, which allow the steel to be 
bent intricately, are much more costly (which may 
not be a problem if your quantity is large enough).

l  
Label
Label stock starts out 
as “regular paper” 
and is fused to a 
backing sheet with a 
layer of sticky stuff in 
between. Some com-
panies specialize in 
selling sticky-backed 
papers; one in New 
York (see Resources at 
the end of this article) 
specializes in mak-
ing regular paper into 
sticky-stock. A few 
mills offer selected 
“name papers” pre-
converted into label 
stock. Label stock as 
discussed here (dif-
ferent from outdoor 
advertising or rolls of 
labels) is mostly sold 
pre-cut into 81⁄2 x 11-
inch sheets. Rather 
than proposing a large 
address label where 
the yield is only two 
per sheet, consider a 
slightly smaller label, 
where the yield would 
increase to three or 
even four per sheet. 

Mills & Merchants
Mills make the paper. Merchants distribute it, 
usually to printers or large-volume end-users. A 
merchant can’t stock every product made by the 
mills it represents, and most merchants can’t afford 
to process small orders. As order minimums have 
increased, merchants have opened paper shops 
where printers and the public can “buy-and-carry.” 
Many mills now sell cut sizes of paper on their web 
sites. The ultimate tool for spec’ing paper is still 
the swatchbook—make sure yours are current! Tip: 
Normally, a swatchbook doesn’t “sample” every 
color in every weight and fi nish. Check the stocking 
chart to learn what’s available.

Vintage 99 Label Brochure

Alpha Key: C, H, L, S, T, X

Design: Ingalls + Associates, 

www.ingallsdesign.com

Printing: Fruitridge Printing,

www.fruitridgeprinting.com

Notes: Debossed cover 

ensures that hand-applied, 

tipped-on label goes on 

straight every time. A pro-

motional piece that practices 

what this producer of high-

end wine labels preaches.

Notecards for Correspondence

Alpha Key: H, L, N, Q, S, T, X

Design, right to left: 

1. Auston Design Group, www.austondesign.com

2. Elixir Design, www.elixirdesign.com

3. Deutsch Design Works, www.deutschdesign.com

4. Elixir Design

Notes: Often replacing letterhead for a casual

yet civil tone, notecards are the hottest trend in

stationery. Engrave, letterpress, or don’t print at

all and personalize with a versatile label.

m
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Q Quantity
The “u” stands for unit cost! Quantity and unit 
cost are part of the same equation. Many designers 
prefer to emphasize unit costs with clients, relating 
the per-piece cost to the hoped-for return on invest-
ment. Presenting only total dollars—or cost per 
thousand—treats the fi nished piece like a commod-
ity. Even when you’re driven by the bottom line, 
it’s always helpful to consider the cost of putting 
a product in the hands of each recipient. Another 
factor is start-up costs, which can range from a rela-
tively small percentage of the total job to a major 
investment. In the latter case, ask your printer or 
converter to quote on higher quantities as well. Your 
client may be willing to invest more money if it 
brings the unit cost down dramatically.

rResults
Reply cards and other response mechanisms are 
often just about checking little boxes, but they can 
also allow recipients to express themselves. A printed 
piece isn’t interactive or instantaneous in the same 
way online information or solicitation can be, but its 
tactile and visual appeal can be effective in enticing 
a response. Many brides now favor RSVP cards that 
leave most of the card blank for the invitee’s self-
expression, and these make great memorabilia.

Citigroup

Alternative View Book

Alpha Key: Q, S, T

Design: Munn Rabôt, 

www.munnrabot.com

Printer: Dickson’s, 

www.dicksons.com 

Notes: Blind embossing on 

right-hand page, registered 

embossing on left. Part of a 

package for high-net-worth 

prospective investors.

PPostage Stamps
Real stamps may be the smallest things designed on 
paper, unless you regard fortune-cookie fortunes as 
designed. Stamps carry messages far greater than 
their diminutive size. Consider the huge success 
of the breast cancer semi-postal stamp, which has 
raised close to $30 million for research. The USPS 
has just issued its first pair of stamps especially for 
wedding invitations and RSVP envelopes, to supple-
ment the long-running LOVE stamp series. Stamps 
can preview your message when selected specifically 
for a mailing. To stay ahead of the philatelic curve, 
put yourself on the mailing list for USA Philatelic, a 
free Postal Service quarterly catalog.  

n  Notecards
Many people now correspond with notecards more 
frequently than letterhead. Notecards are less 
intimidating (to write) than a letter and more dis-
tinctive (to receive) than an e-mail, sticky-note, or 
jot on a business card. A notecard that fits in a letter 
envelope is a versatile component of an identity sys-
tem. They’re well-sized for thank you’s, make a nice 
touch to accompany photocopies or clippings, and 
stand tall in a pocket folder of materials. Consider 
super-heavy stock, colors, and textures.

oOpacity
Opacity isn’t talked 
about much, unless 
you have a job where 
there isn’t enough 
of it! Opaque papers 
have been around a 
long time, but only 
recently showed up 
on “designer radar.” 
Engineered to mini-
mize show-through, 
these “workhorses” 
are manufactured on 
wider, faster machines 
than fi ne text papers. 
A lighter-weight 
Opaque offers excel-
lent value and often 
provides better opac-
ity than a heavier-
weight text. On a 
large mailing, a job on 
Opaque can deliver 
signifi cant savings not 
just in terms of paper, 
but also in reduced 
mailing expense.
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Specialty Printing
There is undeniably a renaissance of letterpress 
printing afoot. Interestingly, an indication of high-
quality letterpress printing used to be the absence, 
or slightness, of an impression. Today, people like to 
feel a “heavy hit;” many letterpressed greeting cards, 
invitations, and annual report covers are deeply 
debossed. Other specialty processes are tactile as 
well: Engraving sits on top of the paper, so it feels 
raised. Thermography, often maligned as imitation 
engraving, also sits atop the paper. It can be effec-
tive when used well, especially for art. There are 
images you can thermograph easily and economi-
cally that would be less successful using any other 
printing process.

t Tactile 
Although paper 
can still be divided 
into “coated” and 
“uncoated,” recent 
papermaking innova-
tions have introduced 
elements that engage 
our senses in two 
ways. Our eyes tell our 
brains, “This looks like 
it will feel interesting. 
Let’s touch it and see.” 
Example: Touch, the 
newest Curious Paper, 
feels like skin because 
of micro-spheres 
of air under its sur-
face. Example: An 
iridescent sheet from 
the Curious Paper 
Collection, Morphing 
Mauve, looks lilac at 
one angle and rosy 
at another. Tip it a 
bit more, and it turns 
twilit, almost pewter, 
because of micro-
particles of mica 
refl ecting light in a 
shifting way. Example: 
Translucent sheets in 
fresh colors that can 
be layered to cre-
ate the illusion of still 
more gorgeous colors. 

u  Unbound
Disparate elements can be intriguing—part of the 
appeal of buffets and flea markets. The concept 
applies to printed pieces, especially when compo-
nents are packaged in an interesting way. We may 
well be in The Age of Kits, with information and 
instructions broken down into well-illustrated 
“sight-bites.” Your project may lend itself to an 
unbound format … inside a glassine envelope, shal-
low box, or miniature pocket folder. Drive response 
with packaging refi nements such as twine that needs 
to be unknotted, or a band that needs to be slid off.

vValue-added
Look for suppliers who truly add value to the prod-
ucts they sell. Matz Paper, a family-owned merchant 
in Los Angeles, adds value to “raw paper” with an 
Announcement Line of fi ne papers converted into 
envelopes, with matching cover stock cut to size, 
including fold-over cards scored and paneled in-
house. Brand-newest colors: Carnival Deeps from 
Smart Papers. And 500 miles north, a grateful 
designer left a voicemail for his print rep, minutes 
after receiving a very complicated wine label: “Wow. 
The client is thrilled. We’re thrilled. Thank you for 
making us look better than we are.” That printer 
thinks of itself as partnering with designer custom-
ers in realizing their visions.

Brand Therapy Conference Brochure

Alpha Key: B, D, T

Design: And Partners,

www.andpartnersny.com

Printing: Dickson’s

Paper: Mirra copper, 12 pt. card, from

M-real Zanders, www.zanders.com

Notes: Refl ective stock required careful

scoring and handling to avoid cracking

and scratching. Demanding dimensional

engineering on wraparound “matchbook” 

cover. Japanese-folded interior pages for

heft and elegance.
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Weight
More extra-heavy cover stocks are available than 
ever before. We love how they look and feel and 
print … but here are some cautions: If your piece 
will be mailed, heavy stock can make a fatal differ-
ence if it pushes you into the next postal ounce or 
pound bracket. Check with your printer to ensure 
a super-heavy stock can run on the press for which 
your job was estimated.

YwhY you became a designer
To work with 26 letters, millions of colors, and 
countless software releases? To communicate, inter-
pret, and create? To merge meaning and beauty? A 
stellar designer, addressing the graduating class at a 
college of art, summed it up: “Design is about solv-
ing someone’s problem by creating something.”

Ze summary
Print on paper is versatile, portable, and tactile. It’s 
more than an antidote to “the electronic almost-
everything.” It’s also the beneficiary of new technolo-
gies that allow you to easily and economically scan a 
sheet of handmade paper for a background, incorpo-
rate the image in a single beautiful card letterpress-
printed from your digital fi le, then scan the card for 
an ad campaign in a magazine. Like the alphabet, the 
world of paper and print is always present, endlessly 
combined, and ever-renewed. g

Playing Card Self-promotion

Alpha Key: S, T, U, Y

Design: The Valentine Group, www.valentinegroup.com

Printing: Dickson’s

Notes: Duplexed stock, lithographed on the pattern side, 

letterpressed on the card side. All “face” cards composed 

of letterforms.

x
Xtend the brand
This concept gets a 
lot of lip service, but 
it’s powerful medicine 
that doesn’t expire. 
Anything printed 
offers an opportunity 
to extend the brand, 
not just by including 
a logo, but by pre-
senting the product, 
service, or cause in 
a manner consistent 
with its intended audi-
ence’s perceptions. 
This relates not just to 
design and copy, but 
to paper selection and 
typography as well. 
Use the opportunity.

Mohawk Superfi ne Swatchbook

Alpha Key: A, E, L, M, W

Design: Mohawk Paper Mills

Notes: Learn a lot and save your-

self time and money by studying 

the stocking chart—weights, 

colors, fi nishes, sheet and carton 

sizes, even if items like envelopes 

are available from the mill.

W
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Recommended 
Resources
Crane & Company, makers of 100% cotton paper, convert their 
own envelopes. In addition to standard business sizes, they offer
social sizes with pleasing proportions. www.crane.com

Curious Paper Collection—Get a feel for these unusually tactile 
papers at www.curiouscollection.com. The penguin will direct 
you, but you’ll have to read the amusing copy for yourself.

Dickson’s, Atlanta—Specialty printer offering many processes 
under one roof, including envelope-converting, duplexing, and 
stamp-perfi ng. 800.241.4811 (ask for CD with virtual tour), or 
www.dicksons.com

Fasson—Now part of Avery Dennison. www.fasson.com is a 
mega-industrial site, but if you click on North America > Products 
> Pressure-sensitive components, you can see all the papers that 
are converted to label stock, including holographic diffraction pat-
terns, fl uorescent pink and chartreuse, and whites for every con-
ceivable application.

FiberMark—Crafters of unusual cover stocks (some with exotic 
textures) and specialty technical papers, including absorbent 
papers (suitable for letterpress) and mottled pressboard in interest-
ing colors. 800.451.4378, or www.fi bermark.com

LV Adhesive—In addition to converting regular paper to label 
stock, LV Adhesive specializes in applying transfer tape, fugitive 
glue, and wafer seals. Just the people to get you into any sticky 
situation. 800.654.0090

Mactac—Starliner and Starluxe are stellar collections of label 
stocks for offset and laser printing. www.mactac.com or call your 
paper merchant for a swatchbook.

Matz Paper—Paper merchant marvels. No sample room, no spec 
reps, just people who are incredibly knowledgeable about paper 
and envelopes. No order minimums. 800.776.4153

Mohawk Paper Mills—Mohawk Superfine, acid-free since its 
debut in 1945, meets ANSI archival standards and serves three 
“generations” of print technology: letterpress, lithography, and 
digital—not to mention fi ne artists the world over. Range of 
text and cover weights, plus label stock. www.mohawkpaper.com 
(check out Paper Basics)

Neenah Paper—See Classic Crest colors available 
as label stock at www.neenahpaper.com (though 
not among the hundreds of products you can buy 
online). The site is super-smooth to navigate; just 
click on Choose a Paper.

New Leaf Paper creates and distributes seriously 
recycled papers. The goal: “Inspire a fundamental 
shift toward environmental responsibility in the 
paper industry.” www.newleafpaper.com

Paper Source offers 10 sizes of envelopes in the 
“p.s. collection.” A current favorite: their A9, 5¾ x 
8¾ inches, which holds a letter sheet folded in half. 
www.paper-source.com

Paper Specs—www.paperspecs.com is a compre-
hensive database for all things paper. For more 
information, see “Workspace Savvy,” page 62.

Stora Enso—A vast range of paper and pack-
aging is available from this multinational at 
www.storaenso.com.

USA Philatelic—The Postal Service’s free catalog 
of stamps, published quarterly. Full color, includ-
ing upcoming issues. Call 800.782.6724. You can 
order directly from the catalog, including the official 
guide to U.S. stamps, updated annually, showing all 
U.S. stamps ever issued. The website www.usps.com 
isn’t great for shopping, but outstanding for business 
mailing information.

Vision Paper cultivates kenaf and makes it into 
paper that recalls the sheets on which we learned 
to write. Their pre-converted large envelopes are 
infi nitely more intriguing than regular kraft. 
www.visionpaper.com

Wausau Papers—Visit the colorful, easy-to-navi-
gate site at www.wausaupapers.com to find distribu-
tors and see ideas for using the entire range of fine
and printing papers. Best of all, click on the Personal 
Search Assistant for a virtual stocking chart.
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By Michelle Taute

Ready to move beyond same-old four-color process and 
standard stock choices? Here’s how to up the ante with
letterpress, screen printing, and printing on plastic.

prowess
printing

Screen-printed poster from factor27 (www.factor27.com)
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While most jobs that cross your desk do just fi ne 
with four-color printing and a standard paper 
stock, certain projects call out for something more. 
It might be an invitation for an upscale event or a 
business card for an industry leader. Perhaps it’s an 
especially important piece of marketing collateral.

The common thread is that need for an extra 
boost to stand out from the crowd—something you 
can easily provide with a beyond-the-ordinary print-
ing process or surface. Let’s examine three ideas you 
can add to your arsenal: letterpress, screen printing, 
and printing on plastic.

Look at letterpress
A perennial favorite for wedding invitations, let-
terpress printing is known for making people take 
a second look—even when they’re not sure why. 
“Letterpress has a really unique tactile feel to it that 
engraving can hint at a bit,” says Christopher Clark, 

top dog at Cave Dog Studio in Salem, Mass., who 
often prints his own projects on a platen press.

He favors the process for short print runs and 
enjoys the fact that it opens up his paper choices to 
things an offset printer could never accept, including 
handmade paper, odd sizes, and truly deckled edges. 
If you’re tackling your first letterpress job, Clark 
recommends you talk with your printer before you 
start designing. The printer will be able to go over 
technical issues and let you know what can and can’t 
be achieved.

In general, a letterpress printer can reproduce 
any font you want if you’re working with computer- 
generated artwork. In letterpress, you can also match 
Pantone colors and work with almost as many colors 
as you like. “The most important thing, I think, is 
not trying to make something that is offset printing,” 
Clark says. He recommends using singular design 
elements and keeping things bolder for letterpress.

A creative self-promo 
for Cave Dog Studio 
(www.cavedogstudio.
com), these letter-
pressed labels (right) 
were stuck on bottles 
of home brew that 
were given to selected 
clients and vendors.

The red dot in the 
center is an experi-
ment with screens, 
which can be diffi cult 
to reproduce with 
letterpress printing. 
“We completely avoid 
screens for the most 
part,” says designer 
Christopher Clark, 
who printed the labels 
himself on a platen 
printing press.

Clark made the out-
line of the dog thicker 
than he would have 
for an offset job to be 
sure it stood out in 
the fi nal product. The 
label is printed on a 
kraft paper stock.

Not sure if letterpress 
is right? “It often 
comes down to the 
material you’re print-
ing on,” Clark says. 
“Sometimes you’re 
working backwards 
from the project to 
see what is appropri-
ate.” CD labels and 
thick bar coasters are 
candidates, along with 
wedding invitations.
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Austin, Texas-based 
factor27’s screen-
printed posters are 
designed on the 
computer, many 
in Photoshop or 
Illustrator. Then the 
layouts are separated 
into spot colors and 
sent out to make fi lm.

Most of factor27’s 
silkscreen posters 
use between two and 
four colors, which are 
normally printed one 
at a time and allowed 
to dry before applica-
tion of the next color. 
“I think a good design, 
of course, can be 
done with one color,” 
says Paul Fucik, one of 
the fi rm’s partners.

“Heavier paper works 
better for screen-
printing,” Fucik says. 
He prints most of 
his posters on 80 lb. 
cover weight or better.

Fucik recommends 
working with a line 
screen of 85 or higher 
for best results.
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“We’re actually trying 
to create a depth of 
fi eld in the card,” says 
Andreas Vavaroutsos 
of Orange32. Materials 
are available in a wide 
range of colors and 
levels of translucence.

Study screen printing
Screen printing, often called silkscreening, is the 
perfect choice for any designer with a DIY bent. It 
creates a tactile, attention-grabbing piece without 
the higher cost of letterpress. “I think it lends itself 
to anything flat,” says Paul Fucik, a partner at fac-
tor27 in Austin, Texas, and a silkscreen enthusiast. 
“It’s easy.” If you want to try your hand, he recom-
mends purchasing a screen printing starter kit from 
Speedball (www.speedballart.com) for around $45 
and trying a simple first project like postcards.

This process works best for relatively simple 
designs that employ two to four colors. “If you’re a 
beginner, make your design loose as far as registra-
tion,” Fucik says. “Always think about registration 
and how your colors match up.” Unlike offset print-
ing, you’ll need to be aware of traps—anyplace where 
two colors overlap—and how they will affect your 
finished design. Fine details, such as fonts under 8 
points, can also be difficult to re-create when you’re 
just starting out. For those who don’t like to get their 
hands dirty, it’s relatively easy to find a screen printer 
to do the work for you, but Fucik suggests meeting 
with the printer before you start preparing art.

Print on plastic
Another way to give a project more weight is to pick 
a literally heftier material. Printing on plastic can 
fit the bill, especially when it comes to business-
sized cards. “It’s going to stand out from anything 
else,” says Andreas Vavaroutsos, creative director at 
Orange32 in Commack, N.Y. “It’s a gimmick. If it’s 
done with good design, it’s a good gimmick. If it’s 
done with bad design, it’s a bad gimmick.”

The firm’s own business cards were printed on 
translucent plastic using a four-color process with 
screens and spot color. Another process is flexogra-
phy, which is generally chosen for longer runs and 
utilizes rubber instead of metal plates. For the most 
part, you can achieve anything on a plastic card 
that you could on a paper one. Plus, you’ll have 
the option of adding a magnetic strip or smart chip 
for added functionality. One sticking point can be 
adjusting colors appropriately for printing on a col-
ored card. “We suggest white,” Vavaroutsos says. “It’s 
really hard to predict the effect of printing colors on 
colored plastic.” 

Michelle Taute (michelletaute@hotmail.com) is 
a freelance writer and editor in Cincinnati who 
specializes in design topics.

This translucent 
plastic business 
card from Orange32 
(www.orange32.com)
is printed both sides. 
On the front is a four-
color rainforest image 
at 60 percent opacity. 
On the back, the logo 
is knocked out of a 
screened-down white.

The green used for 
vital statistics—name, 
address, and phone 
number—is a spot 
color. Cards were 
gang-printed without 
this information for 
economy. Personal 
information can be 
added as the fi rm 
gains new employees.

g

Want to know more?
Here are resources to 
get you started:
•Briar Press offers 
advice on the subject 
(www.briarpress.org).
•Download Crane’s 
brochure on letter-
press basics (www.
crane.com/business/
designerresources/
pdf/cranes_on_
letterpress.pdf).
•Getting It Printed 
by Mark Beach 
& Eric Kenly, 3rd 
ed., $32.99, HOW 
Design Books, 1999, 
www.howdesign.com
•Screen Printing by 
Samuel Hoff, $67.95, 
Delmar Learning, www.
delmarlearning.com
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It’s official: PageMaker 7.0 will be 
the last update of Adobe’s popular 
publishing software. While no new 
versions beyond 7.0 will be forthcom-
ing, legions of PageMaker users can 
take solace in an exclusive upgrade to
InDesign CS.

Adobe calls it the InDesign CS 
PageMaker Edition, and the attrac-
tion for fans is more than just a 
reduced-price upgrade … though the 
cost drops to $349 from $699 for the 
standard edition. The new edition for 
PageMaker owners also provides an 
array of useful capabilities and exten-
sive training materials for those new to 
InDesign. Among the features:
• Extended conversion support for 

PageMaker 6.0 documents (as well 
as 6.5-7 and QuarkXPress 3.3-4 
fi les already in InDesign CS)

• InBooklet Special Edition plug-
in that automatically rearranges 
a document’s pages into printer 
spreads, with complete control over 
margins, gaps, bleeds, creep, and 
crossover traps. This approximates 
PageMaker’s well-liked Build 
Booklet command.

• Automated bullets and number-
ing that update dynamically when 
changes are made (allows adding 
bullets from a different font)

• Data merge for customized publica-
tions like direct mail and catalogs

• A Position tool that resizes and 
moves images and their frames like 
the Crop tool in PageMaker

• Ability to switch keyboard short-
cuts in InDesign CS to match 
PageMaker shortcuts

• A PageMaker-type toolbar to access 
commands with icons similar to 
those in Acrobat and Word

• Total Training video instruction 
discs to help users’ transition 

A
dobe C

S
 

U
pdate

Conquering the 
“blank-page” scenario
While these pluses in the package 
are valuable, the major appeal for 
many current PageMaker users will 
be the template browser and more 
than 80 professional templates cre-
ated by leading designers just for 
this offer. Designers from Adams 
Morioka, CMCD, Concrete Design 
Communications, Gee + Chung, 
HarperCollins, Mucca Design, Scott 
Design, and studio blue have contrib-
uted what amount to flexible iden-
tity suites, and the special template 
browser aids in accessing and 
organizing them.

Compelling reasons
The advantages of InDesign’s close 
integration with other Adobe prod-
ucts such as Photoshop, Illustrator, 
and Acrobat are well-established, and 
InDesign’s native features are con-
tinuing to win converts (error-prone 
editors especially like the multiple 
undo’s). Potential buyers will need to 
weigh their desire for InDesign fea-
tures against their own situations and 
capabilities, such as whether they’re up
for switching to Mac OSX, a require-
ment for InDesign CS. 

Those choosing the InDesign CS 
PageMaker Edition route should ben-
efit from leveraging existing knowledge 
of Adobe products to hit the ground 
running in InDesign.

For more information on the 
Adobe InDesign CS PageMaker 
Edition or the related plug-in 
pack (which will begin shipping 
with Adobe Creative Suite around 
March 15), go to www.adobe.com 
and click on Products.

PageMaker users can ease their way 
into InDesign Creative Suite with a 
low-cost package of extras.

g
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WORKSPACE SAVVY
Tech Tools and Texts

Toolworthy
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Child index
Contemplating par-
enthood? Maybe not, 
but you can still add 
fi nishing touches to 
daycare brochures, 
school newsletters, 
or other projects 
involving children 
without the hassle of 
coordinating photo 
shoots. Index Stock 
Imagery partnered 
with the Scholastic 
Corporation to make 
photos of toddlers 
through teens pub-
licly available at Index 
Stock’s website. 
www.indexstock.com

Invitations: unveiled
Impress your clients with stylish yet classic invi-
tations from Southworth, now offering a line of 
high-end, cotton-fi ber papers developed especially 
for wedding printing needs. The Contemporary 
Wedding collection offers 25 percent cotton fi ber 
in 80 lb. stock. Foil-lined envelopes complement 
classy silver- and gold-bordered invitations, and 
white or ivory cards with matching thank-you notes, 
menus, wedding programs, and place cards. Visit 
Southworth’s website to download free templates. 
Call 800.225.1839 or click on the Wedding Center 
at www.southworth.com.

Total performance
Fast forward to the latest in DVD technology. Total 
Training Presents: The Essentials of Adobe Audition 
and Total Training Presents: The Essentials of Adobe 
Encore each offer three hours of DVD-based 
instruction to help you create captivating audio 
and video projects. Adobe Audition provides guide-
lines for recording, mixing, and editing; looping 
and mixing tracks with digital video software; and 
techniques to make the scripting and batch process-
ing integration simpler. Adobe Encore reveals secrets 
behind building and editing motion-based DVD 
menus, working with multilingual audio tracks and 
subtitles, and maximizing efficiency when integrat-
ing other editing software. $99 each or $169 for 
both, 888.368.6825, www.totaltraining.com 

The Contemporary Wedding Collection



APRIL/MAY 2004 63

The square life
Got an urge to play 
during working hours? 
Advanced offi ce tech-
nology is here to make 
the hours ’til fi ve melt 
away. Cube-a-Door’s 
handy Cube-a-Scope 
is the ideal tool for 
peering over and 
around cubicle walls. 
Monitor your cube 
mates or keep an eye 
out for the boss with-
out ever leaving your 
workstation. No need 
to climb the corporate 
ladder: The Cube-
a-Scope extends to 
see over higher walls. 
$19.95, www.cube-a-
door.com

No lovefest
International Paper provides answers to the ques-
tion, “What happens when you put a designer and 
a printer in the same ring and let them go at it?” 
in its new print promotion titled Via Conversation.
Besides providing a forum for the no-holds-barred 
between design principal Matt Young and printing 
guru Jim Kohler, this promo extolls the virtues of 
the eminently printable, value-oriented Via line of 
text and cover papers. www.ippaper.com

Metal masters
Add color to metal surfaces with Magnutz, the cool-
est magnets ever to grace your fi ling cabinet. They’re 
super-strong. They’re ergonomically designed. And 
you can’t stop with just one … these plastic-coated 
mags stick together in packs of six. $8 per set, 
www.chiasso.com

Virtual paper
Forget fumbling through stacks of swatch-
books in search of the perfect sheet. Log onto
www.paperspecs.com instead and take advantage 
of online help. PaperSpecs Pro is a comprehensive 
database that allows users to customize their paper 
search criteria. Sort by brand, color, manufacturer, 
or fi nish; control the number of search results 
appearing on each page; and order swatchbooks and 
samples online. Visit the website for a free 30-day 
subscription. A simplifi ed version, PaperSpecs Light, 
is available at no cost. www.paperspecs.com 

Textworthy

Letterform legend
“If you improve your drawing skill, you will become 
a better designer,” says type and logo innovator 
Doyald Young in his new book, The Art of the 
Letter, published by Smart Papers. The limited-
edition volume, printed on Smart Papers’ Benefi t, 
Carnival, and Kromekote papers, is available to 
those attending a lecture in one of the 25 cities 
Young will be visiting throughout 2004 in a nation-
wide tour sponsored by Smart and the American 
Institute of Graphic Arts. Contact your local AIGA 
office for a tour itinerary. www.smartpapers.com
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The Art of the Letter by Doyald Young

Opening new dimensions
Open up and say aha! with the OpenGL 
Programming Guide. Open GL, a powerful software 
interface designed to produce high-quality graph-
ics and interactive applications, is ideal for working 
with 2D and 3D computer-generated images. This 
fourth-edition manual targets Open GL 1.3 and 1.4 
users and includes tips on multi-sampled anti-alias-
ing, depth-texturing and shadows, and advanced 
texture application modes. A must-have for devel-
opers using Open GL. $59.99, Addison-Wesley, 
www.awprofessional.com

Continued on page 66
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Dynamic Graphics Classifi eds is a forum for 
innovative desktop products and services. 
Ads include reader service numbers for 
fast, easy response.

Rates
Large ad:
1 issue $936 | 3 issues $889 | 6 issues $845
Small ad:
1 issue $343 | 3 issues $326 | 6 issues $310
Multiple ad per issue rates are also avail-
able. Prepayment must accompany each 
insertion. AMEX/VISA/MC are welcome.

Ad format
Large ad: 2¼ x 4¾-inch. 
Small ad: 2¼ x 1¼-inch. 
Specifications for electronic fi le types, 
fonts, and correct media are available on 
request. Publisher reserves the right to edit 
supplied ads to meet section specifications.

Classifieds rates (3 line minimum)
Per line:
1 time $25 | 3 times $22.50 | 6 times $20

Deadlines
Dynamic Graphics magazine is published 
six times a year. DG Classifi eds clos-
ing is four weeks prior to issue date. For 
more information, call Caroline Rhame 
at 212.260.2777, ext. 28, or e-mail 
rhame@dgusa.com.

CLASSIFIEDS
Sourcing Solutions

Circle 21 on Connections card.

www.dynamicgraphics.com/training 888.698.8545

TODAY’S DESIGNER
“New challenges are emerging in
the design world, and software is 

changing at an incredible speed. Being 
self-taught is no longer an effective 
solution to staying current with the 

ever-changing technology.
TODAY’S DESIGNER needs to update 

his or her skills in the fastest
possible way to maintain
professional strength.”

Instructor, Susan Norman

DYNAMIC GRAPHICS TRAINING

Order your FREE catalog today!

Workshops and Seminars for
the Creative Professional

Professionals Teaching Professionals

Circle 23 on Connections card.
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• Huge Selection 
of Royalty-free 
Maps!

• Globes, World
Maps, Countries,
US states, Cities  

• Fully Layered 

• Easy to Edit
with Adobe®

Illustrator

• DG Readers: 
Get 25% Off  
Any Map 
Purchase! 

• Individual Maps,
CD Collections
Online 24/7 

To Order Call
800 –334 – 4291 
or Go Online— 
Use discount 
code: VQ437

Tropic of Cancer

Equator

Tropic of Capricorn

Huambo

Rosario

Belem

Belo Horizonte

Campinas

Curitiba

Fortaleza

Goiania

Manaus

Porto Alegre

Recife

Rio De Janeiro

Salvador

Sao Paulo

Montreal

Torshavn

Nantes

Toulouse

Es

S

Basra

Cork

Krakow

Constanta

Gorkiy

Kazan

Krasnodar

Kuyby

St. Petersburg

Volgograd

Jaroslavl

Umtata

Barcelona

Sevilla

Valladolid

Adana

Izmir

Frunze

Lviv

Sunderland

Buffalo

Charlotte

Dallas

Detroit

Jacksonville

Atlanta

Kansas City

New Orleans

New York

Boston

Norfolk

Omaha

Likasi

Baltimore

Bayonne

Birmingham

enver

Casablanca

Chicago

Gdansk

Houston

Memphis

MilWawkee

Minneapolis

Philadelphia
Porto

Rostov

Sao Goncalo

St. Louis

Tampa

Tol Yatti

Walvis Bay

Luanda

Ponta Delgada

Minsk

Porto Novo

La Paz

Sucre

Brasilia

Yaounde

Praia

Santiago

Bogota

Havana

Copenhagen

Quito

Addis Abbaba

Port Stanley

Helsinki

Paris

Libreville

Gibraltar

Athens

Reykjavik

Te

Baghdad

Rome

Nairobi

Riga

Tripoli

Kaunas

Antanana

Bamako

Nouakchott

Mexico City

Windhoek

Niamey

Abuja

Oslo

Warsaw

Bucharest

Moscow

Riyadh

Mogadishu

Cape Town

Madrid

Stockholm

Dar es Salaam

Tunis

Ankara

Kiev

Washington D. C.

Montevideo

Caracas

Georgetown

Paramaribo

Sanaa

Kinshasa

Lusaka
Harare

Algiers

Buenos Aires

Gaborone

Ottawa

Bangui

Brazzaville

Nicosia

Cairo

Tallinn

Berlin

Accra

Nuuk

Conakry

Dublin

Abidjan

Monrovia

Rabat

Maputo
Asuncion

Lima

Lisbon

Dakar

Freetown

Bloemfontein

Pretoria

Khartoum

Lome

London

N’Djamena

Asmara

Kampala

Mbabane

FINLAND

AUSTRIA

ITALY

SPAIN

SWEDEN

NORWAY

GERMANY

FRANCE

PORTUGAL

HUNGARY

ROMANIA

BULGARIA

TURKEY

DENMARK

POLAND

BELARUS

UKRAINE
CZECH

SLOVAKIA

GREECE

CYPRUS

NETH.

BELGIUM

IRELAND

YUGOSLAVIA

ALBANIA

MOLDOVA

LITHUANIA

LATVIA

ESTONIA

LUX.

BOSNIA

CROATIA
SLOVENIA

SWITZ.

MACEDONIA

ICELAND

U. S. A.

CANADA

MEXICO THE BAHAMAS

CUBA

PANAMA

EL SALVADOR
GUATEMALA

BELIZE
HONDURAS

NICARAGUA

COSTA RICA

JAMAICA

HAITI

DOM. REP.

ARGENTINA

BOLIVIA

COLOMBIA

VENEZUELA

PERU

BRAZIL

FRENCH GUIANA
SURINAME

GUYANA

CHILE

ECUADOR

PARAGUAY

URUGUAY

FALKLAND ISLANDS

SOUTH GEORGIA ISLAND

KENYA

ETHIOPIA

ERITREA

SUDAN

EGYPT

NIGER

MAURITANIA

MALI

NIGERIA

SOMALIA

NAMIBIA

LIBYA

CHAD

SOUTH AFRICA

TANZANIA

Dem. Rep.

of Congo

ANGOLA

ANGOLA

ALGERIA

MADAGA

MOZAMBIQUE

BOTSWANA

ZAMBIA

GABON

CENTRAL AFRICAN

REPUBLIC

TUNISIA

MOROCCO

UGANDA

SWAZILAND

LESOTHO

MALAWI

BURUNDI

RWANDA

TOGO

BENIN
GHANA

IVORY

COAST

LIBERIA

SIERRA LEONE

GUINEA
BURKINA FASO

GAMBIA

CAMEROON

SAO TOME & PRINCIPE

ZIMBABWE

CONGO

EQUATORIAL GUINEA

WESTERN

SAHARA
(occupied by Morocco)

DJIBOUTI

SENEGAL

GUINEA BISSAU

Canary

Islands

Azores

Cape Verde

JORDAN

ISRAEL

LEBANON

ARMENIA
AZERBAIJAN

GEORGIA

KUWAIT

QAT

U. A

YEMEN

SYRIA

IRAQ

O

SAUDI ARABIA

KAZ

U. K.

A t l a n t i c

O c e a n

www.mapresources.com
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CONNECTIONS
Reference and Interaction

Advertiser Page No.

Big Brand Theory 17 13

Comstock 2–3 3

Copy Craft Printers Inc.  29 7

Corel 11 5

Creatas  14, 65 10

Digital Vision 5 4

Dynamic Graphics Training 9, 64 6

FontShop  64 22

Fox River Paper 13 33

ƒStop Images 64 23

Gilbert Paper Inside front cover 1

Jam Paper 64 24

LiquidLibrary 65, 69 28

Map Resources 64 25

MVB Fonts 64 21

Neenah Paper 24A&B —

Orange32 61 19

Peachpit Press 67 26

Photis 27 14

Photos.com Back cover 30

Photoshop Fix 33, 32A&B 18

PictureQuest 31 16

Print Runner 19 11

PrintingForLess.com 7 8

psprint 15 9

Smart Papers Inside back cover 29

Stock Layouts 20 12

Stora Enso North America 8A&B, 21 15

STRETCH 1 2

Teaching Tools 68 27

Wausau Papers 16A&B —

Within Reach Concepts 64 20

Zinio 32 17

1. For inspiration, access this FREE information

2. Complimentary samples
Circle the number on the attached card to receive complimentary samples or informa-
tion on the products you’d like to know more about.

3. Drop it in the mail
Detach the postage paid card and drop it in the mail.

4. Need it fast?
Fax the attached card to 239.213.2199 or go to www.dgm-connections.com, your 
instant web connection to the samples and information available for the products and 
services offered in this issue of Dynamic Graphics.

Get
Images.

800.255.8800 liquidlibrary.com

Refreshing images and ideas  ... monthly

Get 300 new royalty-free 

images each month, get 

a monthly magazine that 

provides practical tips 

and how-to articles, get 

innovative layouts to inspire 

all your projects and get 

access to over 75,000 online 

images…for one low fee.  

Get liquidlibrary.

Circle 28 on Connections card.

CRE AT AS

Smart.
Compelling. 
Royalty Free.

Endless.

royalty free stock resources
800.255.8800 • www.creatas.com

SS13037PD / PhotoDisc

Circle 10 on Connections card.
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Think natural
Size and symmetry. 
Patterns and perspec-
tive. These concepts 
only begin to scratch 
the surface of the 
many design funda-
mentals addressed 
in Peg Faimon and 
John Weigand’s The 
Nature of Design. 
Beautiful photographs 
of nature, architec-
ture, furniture, and 
everyday objects 
are creatively used 
to demonstrate core 
design principles. 
Faimon and Weigand 
aim to cultivate the 
virtual thinker in every 
designer by spark-
ing the imagination. 
$32.99, How Design 
Books, 800.448.0915,
www.howdesign.com 

Praise the logo
Leslie Cabarga is on a mission to move beyond 
using OPFs—Other People’s Fonts—in her book, 
Logo, Font & Lettering Bible. A mix of creative, 
practical, and unique text-based logos fi ll each page 
to demonstrate effective lettering styles, layout 
and grouping techniques, font do’s and don’ts, and 
more. Suggested exercises provide hands-on experi-
ence, and a fi nal section on selling work will assist 
independent designers. $32.99, How Design Books, 
800.448.0915, www.howdesign.com

Arresting artwork
Illustrator is ubiquitous; the challenge is to make 
it speak your voice. The Adobe Illustrator CS 
Wow! Book addresses the need. Learn to paint 
with symbols, simulate ink and watercolor with 
transparencies, explore new 3D effects, and more. 
An accompanying CD includes over 80 examples 
of artwork from the book, offering readers a 
glimpse of the artists’ design processes. Ideal for 
reference or inspiration. $49.99, Peachpit Press, 
www.peachpit.com

InDesign, InDemand
InDesign for Macintosh & Windows stays true to the 
style of the Visual Quickstart series, where step-by-
step instructions are coupled with corresponding 
screen shots. Learn to incorporate basic text fea-
tures, import graphics, work with layers, and master 
keyboard shortcuts. Author Sandee Cohen has writ-
ten three previous editions of this guide and is truly 
a font of knowledge. Follow her lead and you, too, 
will become adept at InDesign. $24.99, Peachpit
Press, www.peachpit.com  

G-R-8 Paint
Boost your imaging 
skills with Paint Shop 
Pro 8: The Guide to 
Creating Professional 
Images. Get insights 
on manipulating digi-
tal images; adding and 
enhancing text; and 
working with images 
for web-based, com-
mercial, or personal 
printing. Loaded with 
informative explana-
tions and enhanced 
with examples, this 
book is sure to please 
anyone learning 
Paint Shop Pro 8. 
$24.99, Focal Press, 
www.focalpress.com

Apparel appeal
If you’re crazy for Calvin Klein and think DKNY 
is divine, you’ll want to know how these fashion 
savants have employed graphic design to achieve 
their elevated status. Fashion & Graphics by Tamsin 
Blanchard reveals branding secrets of 25 popular 
labels and the fashion/graphic designer partner-
ships behind them. Learn how typography and 
color choice help establish an image, and explore 
conservative and outlandish labels to see why con-
sumers are drawn to them. $35, Harper Collins, 
www.harpercollins.com

Continued from page 63



Master Real World
Techniques
Looking for a guide that skips 
the simple stuff and comes loaded
with industrial strength tips and
tricks that you can use immediately
to do your job faster, better, and
more efficiently? Welcome to the
Real World.

Real World Adobe Photoshop CS
By David Blatner and Bruce Fraser
0-321-24578-4 • $49.99

Real World Digital Video, 
Second Edition
By Pete Shaner and Gerald Everett Jones
0-321-23833-8 • $49.99

Real World Scanning and Halftones, 
3rd Edition
By David Blatner, Glenn Fleishman, 
Steve Roth, and Conrad Chavez
0-321-24132-0 • $39.99

Real World Adobe InDesign CS
By Olav Martin Kvern and David Blatner
0-321-21921-X • $44.99

Real World Adobe Acrobat 6: 
Pro and Standard
By Christopher Smith and 
Mohamad Tawil
0-321-19440-3 • $44.99

Real World QuarkXPress 6
By David Blatner 
0-321-19959-6 • $44.99

Real World Digital Photography, 
2nd Edition
By Katrin Eismann, Sean Duggan, 
and Tim Grey 
0-321-22372-1 • $49.99

Essential books for the creative community

Peachpit

Save 30% and enjoy free UPS ground shipping within the United
States with the purchase of this book at peachpit.com. Just enter
coupon code EM-A4AA-DYGF when you get to our checkout page.
This coupon code is an exclusive offer that may not be used in 
conjunction with any other coupon codes.

Save 30%
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subscribe nowand take advantage 

of bulk subscriptions and student discount rates.

listen to what instructors and students alike are saying about Dynamic Graphics Group publications:

TEACHING TOOLS 
FOR STUDENTS

about STEP inside design magazine:

“As graphic design students, we traverse an

ungodly amount of published material about design 

on a regular basis. Now, we pick up STEP inside 

design every other month and find it to be the most 

content-rich design magazine for the price, delving 

into the finer points of design practices and theory.”

K i m  Z i n g a l e  a n d  P h i l l i p  Z e l n a r, T h e  U n i v e r s i t y  o f A k r o n  ( A k r o n , O h i o )

about SBS Digital Design newsletter:

“Seventy-five percent of our illustration courses have 

a digital component, so I'm constantly on the lookout

for sources of inspiration for my students. I feel SBS 

Digital Design provides it. The articles are concise, 

on-top, and spark students' imaginations with interesting,

contemporary techniques while providing a platform 

for experimentation.”

B i l l  F i n e w o o d , A s s i s t a n t  P r o f e s s o r  o f I l l u s t r a t i o n ,

Ro c h e s t e r  I n s t i t u t e  o f Te c h n o l o g y, Ro c h e s t e r, N e w  Yo r k

about Dynamic Graphics magazine:

“As a teacher, I recommend Dynamic Graphics magazine 

to students to help keep them inspired with ideas and 

up-to-date with the latest in graphic design. I especially 

like that the featured designs are created with software

commonly used in the design world.”

L.B. Fred, Graphics Design Inst ructor, S incla i r  Communi ty  Col lege, Dayton, Ohio

to subscribe call 
Mary Schmidt T 309.687.0123 F 309.688.6579 schmidt@dgusa.com
P.J. Bayler T 309.687.0276 f 309.688.6579 bayler@dgusa.com

FREEBONUSWITH EACH 
SUBSCRIPTION 

(ALL 3 PUBS)
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Better images. 

Better tools. 

Better value.

liquidlibrary images are created by skilled artists and
expert photographers with hours invested in planning,
concepting and styling. These exclusive 50MB high-
resolution model-released images are immediately 
downloadable at liquidlibrary.com. And, no other image
resource provides a 68-page monthly magazine with
instant design solutions and software tips and tricks. 
You get a complete, professional package — images,
ideas, inspiration at an incredible value!

6 months  $399 /     12 months  $699

Get unlimited access to more than 75,000 
exclusive royalty-free images.

To search images, go to liquidlibrary.com     

To subscribe at the special rate, go to: www.liquidlibrary.com/DGM

800.255.8800   liquidlibrary.com

063P0504LL 080P0504LL

096P0504LL

023P1103LL 034P0504LL

089P0504LL
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SOFTWARE SPECIFIC
Solutions for Windows and Mac

Progressing to the Past
Give your art an aged
and distressed look

You don’t have to leave your art out in the pour-
ing rain to make it look weathered. Achieve an 

antiqued appearance through layers, lines, and the             
  Mezzotint fi lter. It’ll take you back to bluegrass and      
   homemade wine in no time.

Corel Painter 
Follow these steps to achieve a similar effect in 
Corel Painter 8. 
1. In Painter, create a new layer for the vertical 

lines. Draw the black vertical lines using a 
Croquil 3 pen, holding down Shift to con-
strain them. If some lines are slightly diago-
nal, leave them as this will only enhance the
distressed effect. 

2. Apply the Distress effect (Effects > Surface 
Control > Distress) to both the canvas and 
the layer containing the lines.  

3. Apply the Negative effect (Effects > Tonal 
Control > Negative) to the lines and set the 
layer type to Screen.  

4. Create a new layer and use the Fill com-
mand (Effects > Fill) to fi ll the layer with 
orange. Set this layer to Screen as well.

Tip: The drawn vertical lines appear even bet-
ter if you have a Wacom tablet, as the tab-
let’s pressure sensitivity enhances the natural 
look of the distressed effect by creating thick 
and thin lines.  

PHOTOSHOP
QUICK TIP
To make quick copies 
of your vertical lines 
in Step 2, Command-
click Layer 2 to select 
it. Using the move tool 
(V), hold Option + 
Shift while dragging to 
the right to duplicate 
the line. Repeat this 
to create a random 
pattern, and choose 
Select > Deselect 
(Command + D).

MW

2

2. Select the line tool 
in the toolbox. In the 
resulting Options 
toolbar, click the Fill 
Pixels icon and set the 
line weight to 2 pixels. 

1. In Photoshop, click 
the Create New Layer 
icon at the bottom 
of the Layers palette. 
Then click Layer 1’s 
visibility icon to hide 
the layer. 

1 Photoshop

Draw randomly placed 
vertical lines from top 
to bottom, holding 
down Shift to keep 
them straight.

g
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3. Change the line 
weight to 4 pixels and 
draw half as many 
shorter lines directly 
next to the existing 
ones. Command-click 
Layer 2 to select the 
lines. Choose Select > 
Save Selection. Name 
the channel “Lines.” 
Choose Select > 
Deselect. Drag Layer
2 to the trash icon.

4. Open the Channels 
palette and select the 
Lines channel. Choose 
Image > Adjustments 
> Invert. Choose Filter 
> Pixelate > Mezzotint, 
and set Type to 
Coarse Dots. Next 
choose Edit > Fade 
Mezzotint, and set the 
options (middle left).

5. Choose Filter > 
Pixelate > Mezzotint 
again, and set Type to 
Medium Strokes. Then 
choose Edit > Fade 
Mezzotint, and set the 
options (lower left).

6. In the Layers pal-
ette, reveal Layer 1. 
Choose Select > Load 
Selection, and select 
the options shown 
(above right). Click 
the Add Layer Mask 
icon at the bottom of 
the Layers palette.

7. To colorize the art 
in a weathered brown, 
click the Layer thumb-
nail. Choose Image > 
Adjustments > Hue/
Saturation. Check the 
Colorize box, and set 
the values as shown 
(lower right). 

3

4

5

7

6
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COVER TO COVER
Up Front, Start to Finish

Crop ’til you drop
When shooting a 
photo, capturing the 
subject is the single 
most important fac-
tor. But we often have 
to deal with existing 
images that have too 
many extraneous ele-
ments or more than 
one subject. Few pho-
tos can be used as is, 
and it’s good policy 
never to be satisfi ed 
with an original image: 
Crop until you’ve gone 
too far, then take half 
a step back. In the 
case of this photo, 
we also started with 
a strong horizontal 
orientation. Judicious 
cropping solved both 
of the problems and 
resulted in an image 
that says just enough, 
all by itself.

Options
We evaluated paper 
dolls, rolls of paper, 
and the image at right, 
which was eliminated 
when we spotted a 
similar one on the 
cover of Wired.

Coming Up
A carefree insignia of tropical intent was our choice for the 

cover of this print-packed issue. While posing the risk of 
revealing our staff ’s hidden desire to get away to some-

place sunny, sandy, and sans souci, the image had an 
appeal that was (pardon the pun) breezy. Should we 

mention it was also a way to get another “line” on the cover?
Concepts with a wide range of associations can be frustrating 

to capture in a single image. The word print recalls everything from 
yesterday’s press check to this morning’s coffee and newspaper. Which 
association to choose? Which medium could possibly stand for the 
whole world of print?

Our decision in this case was to select a symbolic approach. And 
it just happens to give us all the opportunity to take a much-needed—
although vicarious—spring break.

Cover photo available from Creatas, www.creatas.com: TES0045CB

g

Before

After

We hate to gloat … but we were there 
fi rst. In a year when all things made-over 
are at the forefront of pop culture, we’re 
celebrating our seventh year of highlight-
ing design makeovers. In the expanded 
June/July issue, our designers apply some 
Cinderella magic to readers’ real-world 
challenges, including:
• Brochures
• Newsletters
• Logos
• Websites & more

Plus the second of “6 Steps to Better 
Color” and the usual tips and tools to help 
you master your own real-world missions.


